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Picarro Notices
Thank you for purchasing a Picarro product. Your Picarro system is a quality product that has been designed and 
manufactured to provide reliable performance.

This User Manual (UM) is an important part of your purchase as it will help familiarize you with the system and 
explain the numerous features that have been designed into it. Please read this manual thoroughly before using 
your Picarro system.

Please contact Picarro or your authorized Picarro distributor should you have questions regarding specific 
applications or if you require additional information.

DISCLAIMER AND RESERVATION OF RIGHTS

Picarro has prepared this manual solely for the information and use by its customers as a guide for the selection, 
installation, operation, and maintenance of the products described.

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO PRODUCTS, PICARRO 
ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, 
RELATING TO SALE OR USE OF PICARRO PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Picarro reserves the right to change or update the contents of this manual and the specifications of its products at 
any time, without notice. Picarro has endeavored to include information that is current and accurate as of the date 
of the publication or revision of this document, but Picarro does not guarantee that this document is error free or 
that it is accurate with regard to any particular specification.

Picarro expressly reserves all intellectual property rights, including all intellectual property rights relating to any 
product described in this manual. This document does not grant any license, express or implied, by estoppel or 
otherwise, to any intellectual property rights of Picarro or any third party.

PATENTS

The products described in this manual are subject to Picarro patents and patents pending. Information about 
Picarro patents applicable to these products is available at www.picarro.com/company/patents

TRADEMARKS

  Picarro and the Picarro logo are trademarks of Picarro, Inc.
  Ball® is a registered trademark of Ball Corporation

  Linux® is a trademark of Linus Torvalds

  Molex® is a registered trademark of Molex LLC

  SilcoNert® is a trademark of SilcoTek® Corporation

  Snoop® is a registered trademark of Swagelok Company.

  Swagelok® is a trademark of Swagelok Company.

  Teflon™ is a trademark of the Chemours Company

 

Copyright © 2024 Picarro, Inc. All rights reserved.

https://www.picarro.com/company/patents
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Revision History

Revision Date Notes

A
September 
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USB device removed from shipping contents. Not 
applicable.
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1 Introduction

1.1   Intended Use
The PI2103 analyzer measures concentrations of ammonia (NH3) using Picarro’s patented 
Cavity Ring-Down Spectroscopy (CRDS) technology to deliver stable measurements of NH3 
with a parts-per-trillion (ppt) lower limit of detection (LOD) and negligible drift. The analyzer 
can be deployed in a lab or in the field, allowing in-situ analysis for both trace and ambient 
amounts. See the PI2103 datasheet for more information.

Any protective equipment shall be used in accordance with the instructions provided by 
the protective equipment supplier.

Users must obtain the MSDS for sample gasses used in the proxy validation procedure 
for their respective suppliers.

1.2   System Overview

1.2.1 Analyzer Front Panel
The following figure shows the analyzer front and panels. For more information on panel 
features, functions, and connections, see Chapter 4, Hardware Setup.

Figure 1 - PI2103 Front Panel

CAUTION

NOTE



1 Introduction

14 PN 40-0120, REV B PI2103 User Manual

The LED indicator on the front panel shows the current operating state of the analyzer. The 
following table describes the status indicator states. 

The five status states and colors are linked to the System Alarm Panel on the CRDS Data 
Viewer Screen, see 6.3, Alarms Panel.

Table 1 - Front Panel Function

Feature Color Dsecription

Status Indicator LED

Off: System is off or has no power.

Yellow (flashing): Warming up.

Green: Operating correctly.

Yellow (steady): not operating correctly.

Red: Not measuring.

USB Port NA For transferring files to a flash drive. 

1.2.2 Analyzer Back Panel

Figure 2 - PI2103 Back Panel
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1.2.3 A2000 Vacuum Pump
The A2000 vacuum pump is used to maintain cavity pressure inside the analyzer. The pump 
should be connected and running whenever the analyzer is in use.

 

Figure 3 - A2000 Vacuum Pump – Side Views

1.3   Analyzer Specifications

Table 2 - PI2103 Specifications

Parameter Specifications

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS)

Weight: Analyzer

Weight: Pump

21.7 kg (48 lbs.) – Should be lifted by two people.

A2000: 6.5 kg (14.4 lbs) 

Dimensions - Analyzer

Depth: 62 cm (24.4”)

Width: 43.2 cm (17”)

Height with Feet: 21.3 cm (8.4”)

Dimensions – A2000 Pump

Length: 27.9 cm (11”)

Width: 10.2 cm (4”)

Height: 19.1 cm (7.5”)

Ambient Humidity Range < 85% RH non-condensing

Ambient Temperature Range
Operating: 10 °C to 35 °C (50 °F to 95 °F) 

Storage:    -10 °C to 50 °C (14 °F to 122 °F)

Maximum Altitude 

(During operation)
3,048 m (10,000 ft)
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Parameter Specifications

Front/Rear Clearance Front: 15.3 cm (6”); Rear: 15.3 cm (6”)

Primary Gases Measured NH3 (ammonia)

Sample Flowrate >1.5 SLPM 

Required Accessories
Included: Pump (external), keyboard, mouse

Supplied by Customer: LCD monitor

Operating System Linux

Data Outputs
RS–232, Ethernet, USB, Analog 0-10 V, Modbus and 
4-20mA optional

Installation Benchtop or 48.3 cm (19”) rack mount

Power Requirements

Startup Power

Steady-state Power

Mains Supply Voltage Fluctuation

100 – 240 VAC; 47 – 63 Hz (auto-sensing)

<375 W at start-up, (Analyzer and Pump)

120 W (Analyzer)

150 W (A2000 Pump)

±10% of the nominal voltage

Minimum Rated Circuit Amperage
10A @ 115 VAC

5A @ 230 VAC

Liquid Ingress Protection None

1.4   Acronyms
This manual includes various acronyms. For definitions, see below: 

Table 3 - Acronyms, Formulas, Units, and Symbols

Acronym Definition

“(as in 
1/4”)

Inches

°C degrees Celsius 

< Less Than
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Acronym Definition

> Greater Than

‰ per mil 

A Ampere

AC Alternating Current

cm Centimeters 

COM Communication Port

CRDS Cavity Ring-Down Spectroscopy 

CSV Comma Separated Values

CPU Central Processing Unit

DAS
Data Acquisition System (the Analyzer)
(Note historical name, may no longer be used)

DC Direct Current

DIO Digital Input/Output

DVI Digital Visual Interface

ESD Electrostatic Discharge

°F Degrees Fahrenheit

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm)

GUI Graphical User Interface 

H2O Water, Water Vapor

HDF Hierarchical Data Format

Hz Hertz

ID Inside Diameter

I/O Input/output

kg Kilograms

lbs pounds
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Acronym Definition

M meters

m meter

max Maximum

min Minimum

mA Milliampere

mL Milliliter

mK Millikelvin

mm Millimeters 

nc new calibration

N/C No Connection

NC Normally Closed

NO Normally Open

NTP Network Time Protoc

OD Outside Diameter

P Pressure

PC Personal Computer

PDF Portable Document Format

PFA
Perfluoroalkoxy Alkane – A chemically resistant polymer, suitable for use with 
sticky and aggressive gases

PN Part Number

ppb parts per billion 

ppm parts per million 

PSI (psi) Pounds per Square Inch

PSIG Pounds per Square Gauge

Pws Water vapor pressure
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Acronym Definition

RH Relative Humidity

RJ-45 Registered Jack (physical network interface)

RS232 Recommended Standard 232 (serial communication protocol)

sec Seconds

SLPM Standard Liters Per Minute

SS Stainless Steel (i.e., tubing)

Torr Torricelli (unit of pressure equal to 1/760 atmosphere)

UM User Manual

USB Universal Serial Bus

UPS Uninterruptible Power Supply

VA Volt-Ampere

VAC Volts AC power

VDC Volts Direct Current

W Watts

WS-CRDS Wavelength Scanned Cavity Ring-Down Spectroscopy

1.5   Text Conventions
The following conventions are used in the manual.

 l Italic text identifies screen names and emphasizes important text or certain 
features.

 l Bold Italic text identifies section reference links.
 l Bold text is for actions to take (such as clicking on a UI button), caution and warning 

statements, and text you should type or select in screens.
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2 Safety

2.1   Warning Symbols
The purpose of these icons is to provide a visual convention to alert you of important 
information. They indicate dangers to either the operator or to the product, and other 
important information. The following symbols are used in this manual.

DANGER indicates an imminently hazardous situation that, if not avoided, will result in 
death or severe injury.

WARNING indicates a potentially hazardous situation which, if not avoided, could result 
in death or severe injury.

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to electrical energy 
that is high enough to cause injury or death.

LASER WARNING alerts user of a laser danger.

CAUTION alerts user of a potential danger to equipment or to the user.

HOT SURFACE alerts user to potential injury from hot surfaces.

DANGER

WARNING

WARNING

WARNING

CAUTION

HOT SURFACE
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The NOTE is important information that you should be aware of before proceeding.

REMINDER is a helpful hint for procedures listed in the text.

2.2   General Safety

2.2.1 CDRH Certification
This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and is classified as a 
Class 1 laser system when all panels and covers are on.

2.2.2 CE Certification
This Picarro analyzer complies with European safety standards and the instrument is affixed 
with a CE label. This CE label is located on the back panel of the instrument.

Using this analyzer in a manner not specified by Picarro may result in damage to the 
analyzer and render it unsafe to operate.

The analyzer is for indoor use only and has an ingress protection rating of IPx-0. It is NOT 
protected against exposure to water including dripping, spraying, splashing or 
immersion.

Do not operate in an explosive atmosphere! Do not operate in the presence of flammable 
gases or fumes.

NOTE

REMINDER

WARNING

WARNING

WARNING
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This analyzer contains no user-serviceable components except the particulate filter, 
CPU fan, and A2000 vacuum pump diaphragms and valves. To order user-replaceable 
parts and access video replacement instructions, see Chapter 11, Maintenance. 

Do not attempt other repairs; instead, report all problems to Picarro Customer Service or 
your local distributor. Please contact Picarro if you have any questions regarding the 
safe operation of this equipment.

Do not replace the mains supply power cord with an inadequately rated cord.

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

Equipment Damage: Exceeding gas inlet pressure or temperature specifications could 
result in damage to the instrument. In the case of higher input pressure or flow, 
configuring a sampling bypass manifold system is recommended.

Use a ‘tee’ at the gas inlet and exhaust the remainder of the gas stream appropriately.

The inlet gas connector on the back panel of the Analyzer, and its immediate vicinity, 
runs hot during operation of the analyzer. Take care when connecting gas lines or 
working at the rear of the instrument to wear protective gloves or avoid contact with 
these surfaces.

CAUTION

CAUTION

WARNING

CAUTION

HOT SURFACE
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Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum line, or 
the AC power to the External Vacuum Pump while analyzer is operating. Damage may be 
caused by current surges if power is applied while attaching or removing cables.

This analyzer weighs 21.7 kg (48 lbs.). Use the technique described below (or follow your 
local regulations) when lifting the analyzer.

1. Before lifting, inspect the unit for slippery substances or sharp edges.

2. Lift with two people, one on each side of the analyzer.

3. Crouch down and stay close to the unit. Always keep your back as straight as 
possible. 

4. Position your feet for sturdy balance. Lift with your legs, not your back.

5. Do not twist the back while carrying the unit. Rotate direction with hip joints.

6. Lower the unit by bending at the knees.

2.3   Laser Safety

This equipment is classified as a Class 1 laser product with an embedded 3B laser in 
accordance with EN 60825-1:2014. Do not to open the enclosure where this label is 
placed; there are no user serviceable parts inside.

The following laser safety label is affixed to the outer cover of the analyzer.

Figure 4 - Laser Safety Label – Affixed to Outside Cover of Analyzer

CAUTION

WARNING

WARNING
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The laser is a Class 3B when exposed. 
Only operate or service this device in accordance with the instructions in this guide, and 
only open the device in an approved laser safe service area using appropriate laser-
safety glasses.

The following laser safety labels are affixed to the inside of the analyzer:

Figure 5 - Laser Safety Labels – Affixed to Inside of Analyzer

Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous radiation exposure.

WARNING

CAUTION
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3 Unpacking
Picarro products are inspected and tested before leaving the factory. Their packing 
containers have been designed to keep the equipment safe from damage during transit.

3.1   Inspect the Shipping Boxes
Inspect the condition of all boxes upon arrival. The larger box includes the analyzer and most 
of the accessories. Even if the outer box shows damage, the inner box holding the analyzer 
will protect the instrument under most circumstances.

If the equipment does appear to be damaged, photograph the damage and contact Picarro 
(email pictures) as soon as possible.

Keep all packing materials so the instrument can easily be returned Picarro if necessary 
or transported to another location.

3.2   Unpack Components
While unpacking each shipping box:

 l Inspect each item to ensure it is not damaged. 
 l If items are missing, contact Picarro.
 l Keep the shipping materials to reuse when transporting the analyzer.
 l Contact Picarro for options on transporting systems to remote labs.

This analyzer weighs 46 lbs. (20.9 kg). Use the technique described below when lifting 
the analyzer.

1. Before lifting, inspect the unit for slippery substances or sharp edges.

2. Lift with two people, one on each side of the analyzer.

3. Crouch down and stay close to the unit. Always keep your back as straight as 
possible. 

4. Position your feet for sturdy balance. Lift with your legs, not your back. 

5. Do not twist the back while carrying the unit. Rotate direction with hip joints. 

6. Lower the unit by bending at the knees.

NOTE

WARNING
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The following shipping contents may arrive in one or more shipping containers.

Table 4 - Shipping Contents

Part (qty) Description

Analyzer (1)

Includes all the data acquisition, control, and 
communications hardware and firmware to perform all gas 
handling, spectral collection, and analysis.

AC Power Cables (1)

A power cable with connectors appropriate to your country 
is provided. Note: The analyzer automatically adjusts to 
local voltage. 

Control Cable Kit (1)

For external solenoid valves.

Nut (1) and Ferrules (2)

For connecting input line to analyzer gas input.

NOTE
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Part (qty) Description

Vacuum Hose (1)

Hose to connect the pump to the analyzer.

Rails (1 set)

Mounting rails for cabinet installation.

Keyboard and Mouse (1)

Monitor is not included.

Document Packet (1)

Includes this user manual and certificate of compliance (not 
shown).

A2000 Vacuum Pump (1)

Provides vacuum required for sample gas sequencing into 
and out of the analyzer.
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Part (qty) Description

AC Power Cable (1)

A power cable with connectors appropriate to your country 
is provided. 

Note: The vacuum pump voltage must be selected. See  in 
section . 

Pump Manual (1)

Detailed instructions for pump.



4 Hardware Setup

PI2103 User Manual PN 40-0120, REV B 29

4 Hardware Setup
Read this entire section before proceeding. Some of the setup instructions in this section are 
model-dependent.

4.1   Items/Tools Required
 l Analyzer and accessories included in shipment
 l Pump (model dependent; see specifications in 1.3, Analyzer Specifications) and 

accessories included in shipment
 l 9/16” open end wrench
 l 11/16’’ open end wrench
 l Power Cords for analyzer and pump

4.2   Installation Safety

Two-person lift required: The analyzer weighs 21.7 kg (48 lbs). When lifting the analyzer, 
use the technique described on page 23 (or follow your local regulations).

When the analyzer is being integrated to an external system, the safety of that system is 
the responsibility of the assembler of that system.

Equipment Damage: Do not attach electrical power to or start the analyzer until after 
attaching and turning on the External Vacuum Pump. Do not disconnect the vacuum line 
while the analyzer is running. Failure to do so could result in damage to the optics.

Picarro sells certain USB enabled devices, such as GPS, which are approved for use. Do 
not connect USB hubs or unauthorized USB devices (except flash drives, mice, and 
keyboards) to the USB ports. Unauthorized USB devices may interfere with the normal 
functioning of the analyzer.

WARNING

CAUTION

WARNING

WARNING
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When using compressed gases, follow all appropriate safety conventions, including use 
of eye protection, physical restraint of cylinders, etc.

Lines connected to the 1/4” Swagelok sample inlet connector must not exceed 15 PSIG 
of pressure.

During installation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or breaker).

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

Use the AC power cables supplied with the analyzer or a similarly rated cable. Check 
with Picarro technical support if you have questions about power cable replacement. An 
inadequately rated power cable can result in equipment damage.

Cords shall be RATED for the maximum current for the equipment and the cable used 
shall meet the requirements of IEC 60227 or IEC 60245. Cords certified or approved by a 
recognized testing authority are regarded as meeting this requirement. The connector 
type used should be: IEC320 C13.

WARNING

CAUTION

CAUTION

WARNING

CAUTION

CAUTION
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Equipment Damage: It is imperative that the analyzer have adequate ventilation and/or 
cooling to maintain the ambient temperature below 35 °C when operating.  Do not place 
the pump or the instrument in any enclosure without providing adequate forced air flow.

Do not plug or block any perforations in the chassis of the instrument. Do not put 
anything near the instrument that will impede the air flow. Failure to provide adequate 
airflow, especially clearance at the front and rear panels, to ensure proper airflow and/or 
cooling to the analyzer will result in overheating of the analyzer causing a shutdown and 
potential damage. There should be 6” (15 cm) of clearance in the front and back of the 
analyzer.

To determine if the ventilation is adequate in an enclosure, monitor the temperature of 
the air near the instrument and adjust ventilation so that the ambient temperature is 
within specification. As a guide, the ambient temperature of the air around the 
instrument cannot exceed the specifications listed below

Thermal 
Specifications

Min Max Description

Ambient Operating 
Temperature

10 °C 35 °C
Worst-case environmental limits 
(unless otherwise specified)

If the analyzer has been stored at less than 10 °C, allow the components to equalize to 
room temperature before starting the installation process.

4.3   Analyzer Preparation

4.3.1 Ventilation Considerations
The instrument and pump require adequate ventilation in order to function properly. Do not 
plug or block any perforations in the chassis of the instrument. Don’t place anything near the 
instrument that will impede the air flow. 

CAUTION

CAUTION
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4.3.2 Positioning
1. Remove the analyzer and the external vacuum pump from the shipping container.

2. Install the analyzer in a rack or place it on a cart or table.

3. Place the external vacuum pump near the analyzer in a rack, or on a cart or table.

4. Unpack the analyzer accessories (vacuum line, cable kit, manual, and certificate of 
compliance).

Store the certificate of compliance in a safe place. It may be required if you contact 
Picarro for service or questions.

5. Remove the caps from the analyzer SAMPLE inlet and VACUUM connection ports. 

6. Remove the caps from the pump vacuum inlet (and exhaust port if using an A0702 or 
S2000 pump). Save the caps for reuse in case the analyzer and pump is stored, moved, 
or shipped.

4.3.3 Set A2000 Pump Input Voltage
If using an A2000 vacuum pump, set its input voltage to the correct level for your area by 
rotating the voltage selector switch located on the side of the pump next to the fuse holder as 
show in the following figure.

Input Voltage Selector

Figure 6 - Vacuum Pump Voltage Selection

4.4   Connections – A2000 Pump and Gas Inlet
Follow instructions in this section when using an A2000 pump with your analyzer.

4.4.1 Pump Connections
Refer to the following figure when using an A2000 pump with your analyzer.

NOTE

1



4 Hardware Setup

PI2103 User Manual PN 40-0120, REV B 33

Figure 7 - Analyzer Setup with A2000 Pump

When working with hazardous gases, remove the pump exhaust muffler and adapt a 
tube to the vacuum pump exhaust port (Figure 7) and direct the exhaust to a safe place 
for venting the mixture of sample gases. For instructions, see Appendix B, Setting up 
Contained Exhaust Flow.

1. Connect the provided vacuum line between the analyzer port labeled VACUUM and the 
pump vacuum inlet. 

2. If working with hazardous gases, see  for instructions on directing the pump exhaust to a 
safe venting environment.

4.4.2 Sample Gas Inlet Connections 
There are two types of sample Inlet connections which are model-dependent. 

 l Analyzers that have stainless steel (SST) sample inlet connectors.
 l Analyzers that have PFA sample inlet connectors.

CAUTION
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4.4.3 Sample Gas Inlet Connection (SST Tubing)
1. Use 1/4” OD SST tubing and connector sets to connect from sample source to the 

sample inlet.

2. Place the two ferrules inside the nut as shown below.

Figure 8 - Orientation of Inlet Nut and Ferrules

3. Loosely connect the nut to the inlet on the back panel of the analyzer, being careful not to 
let the ferrules fall out.

4. Insert the tubing into the back of the nut and through the ferrules, feeding it in as far as 
possible without deforming the tubing.

5. Hand tighten the nut.

6. Using a 9/16" wrench (not included), tighten the nut 1-1/4 turns.

When reconnecting SST tubing:

1. Inspect the ferrules. If you see any damage, replace the ferrules and follow the directions 
above for making a new connection.

2. If there is no damage, hand tighten the connector to the analyzer sample inlet.

3. Using a 9/16" wrench, tighten the nut 1/6 of a turn (60°).

4.4.4 Sample Gas Inlet Connection (PFA Tubing).

When making a new PFA gas inlet connection: 

1. Use 1/4” OD PFA tubing and connector sets to connect from sample source to the 
sample inlet.

2. Place the two PFA ferrules inside the PFA nut as shown in the following figure.

Figure 9 - Orientation of Inlet Nut and Ferrules
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3. Loosely connect the nut to the inlet on the back panel of the analyzer, being careful not to 
let the ferrules fall out.

4. Insert the tubing into the back of the nut and through the ferrules, feeding it in as far as 
possible without deforming the tubing.

5. Hand tighten the nut.

6. Using a 5/8" wrench, tighten the nut 1-1/6 turns (1 full turn plus another 60°).

When reconnecting PFA tubing

1. Inspect the ferrules. If you see any damage, replace the ferrules and follow the directions 
above for making a new connection.

2. If there is no damage, hand tighten the connector to the analyzer sample inlet.

3. Using a 5/8" wrench, tighten the nut 1/6 of a turn (60°).

4.5   Electrical Connections
Refer to the following figure for connection points.
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External Vacuum Port to Vacuum 
Pump

Gas Sample Inlet

External Filter (Inlet)

USB Ports (4 ea)

Display Port

HDMI Video Monitor Port

COM 2 Port (Rotary valve – A0311, 
A0311-S)

COM 1 Port

DVI-D Digital Video Interface

USB Ports (2 ea) 

Ethernet Ports – RJ-45 (2 ea) 

Audio In/Out Ports

AC Power Input and Power ON Switch

Valve Control Port (Solenoid valves)

DIO (Only for PAL autosamplers; not 
used with this instrument; not 
connected)”

COM 3 Port (Connected but typically 
not used.)

USB for Logic Board (Not connected)

Analog Out 0-10V

Analog Out 4-20mA (optional)

Figure 10 - Back Panel Connection Diagram

1. Connect a monitor to one of the DVI monitor ports at the back panel. The analyzer will 
detect the connection and adjust the resolution to match the monitor.

2. Connect a mouse and keyboard to a pair of USB ports.

3. Connect the provided AC power cable from the analyzer to the power source.

The analyzer has a universal power supply that automatically adjusts to power 
sources ranging from 100-240 VAC, 50/60 Hz, 10 A max.

The A2000 pump does not automatically adjust to power sources. If using the A2000 
vacuum pump, ensure its input voltage is set to the correct level for your area by 
rotating the voltage selector switch located on the side of the pump next to the fuse 
holder (see Figure 6).

4. Check that the A2000 pump voltage input switch is set correctly.

5. Connect the provided AC power cable from the vacuum pump to the power source.

1
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6
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NOTE
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6. If used, connect the valve cable from the analyzer back panel to any solenoid valves.

7. If used, connect rotary valve (A0311 or A0311-S) to COM2 with its provided serial cable.
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5 Analyzer Basic Operation
This section explains how to operate the analyzer using the GUI. It describes system startup, 
shutdown, and recovery procedures. GUI functions are detailed in section Chapter 6, List of 
GUI Functions.

Using this analyzer in a manner not specified by Picarro may result in damage to the 
analyzer and render it unsafe to operate.

During operation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or breaker).

The illustrations shown in this chapter are for example only. What is shown on your 
instrument is dependent on the model analyzer in use and may differ.

5.1   Startup
1. Make sure the pump vacuum hose is connected between the analyzer and pump.

Always turn on the external pump before powering up the analyzer. This ensures a 
safe start-up sequence.

2. Verify the power cable to vacuum pump is plugged in.

3. Switch power on at the pump.

4. Verify the power cable to the analyzer is fully inserted into the power receptacle.

5. At the analyzer back panel, press the main power switch to the ON ( I ) position.

6. Press the round On/Standby button on the rear panel. The LED indicator illuminates 
green.

The software starts automatically, and the analyzer displays the Picarro Launch Pad as 
shown in Figure 13.

WARNING

CAUTION

NOTE

CAUTION
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On a cold start, upon reaching this screen, there will be a 30-second countdown, after 
which the analyzer will automatically start in CRDS mode, or the previous selection if 
manually overridden. The user can click anywhere or click any key on the keyboard to 
stop the countdown. To start the CRDS Data Viewer manually, see 5.4.1, Home Menu.

When initialization is complete, the CRDS Data Viewer GUI displays and provides displays 
graphs for NH3 as shown in Figure 11. This section describes the Data Viewer, the analyzer’s 
main screen.

After the Data Viewer loads, the analyzer warms up before starting measurements. During 
this warmup period the System Alarm box flashes yellow and the Cavity Temperature, Cavity 
Pressure, and Box Pressure displays. For more information, see 6.5, Instrument Status.

When the analyzer is warm, the data screens switch to displaying NH3 concentrations. The 
System Alarm box becomes solid green and a ‘Measuring…’ message displays in the 
Measurement Status field. 

Analyzer initialization is complete, the Data Viewer screen displays, and sampling begins. 
Figure 11 shows the Data Viewer measurements for ammonia.

Data is saved automatically whenever the analyzer produces data. The data displayed on the 
CRDS is the continuous real time read-out from the analyzer. A user-relevant subset of this 
data is stored in:

/home/picarro/I2000/Log/Archive/YYYY-MM-DD/DataLog_User/ 

where Y = year, M = month, D = day

For more information, see Chapter 8, File Management.

In order to measure discrete samples (such as individual gas bags) or from multiple locations 
(when switching valves draw in ambient air from different heights) a separate software 
window (coordinator) is used to control the sample source and match the corresponding real 
time read out with the sample source. Depending on system configuration, coordinator 
programs may not be included.

NOTE
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Figure 11 - CRDS Data Viewer Screen

5.2   Shutdown 
This section describes how to safely shutdown the analyzer using dry gas, closing the CRDS 
application, and powering off the instrument from the Picarro Launch Pad.

A flow of clean, dry gas should always be directed to the instrument for several minutes 
prior to shutting down. Trapping a high-moisture content gas sample in the cavity can 
cause condensation damage to the mirrors as the instrument cools from its operating 
temperature.

Do not turn off the pump or disconnect the vacuum line while the instrument is 
operating. 

CAUTION

CAUTION
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5.2.1 Flow Clean, Dry Gas (When Using an A2000 Pump)
1. With the pump still running, switch to a source of clean, dry gas at the sample inlet and 

allow it to run until the water channel reading on the GUI falls below 2000 ppm. This will 
prevent any damage from condensation to the cavity surfaces. This dry gas may be from 
a tank (target 2-3 PSIG pressure) or from a desiccant column like the DrieRite column, 
C0360, sold on store.picarro.com).

5.2.2 Shutdown (CRDS Data Viewer)
1. Click on the Quit button from the botom left side of the Data Viewer window.

2. A message displays prompting the user to confirm the shutdown. Once confirmed, the 
analyzer software and hardware will turn off.

3. Note you must be logged in to shut down the analyzer.

Figure 12 - Analyzer Shutdown Dialog

4. Manually turn off the pumps and dry gas only if system requires it.

Leave any dry gas or desiccant attached to the inlet during this process.

5. From the Picarro Launch Pad select Power Off to tun off the hardware.

6. When the instrument fans audibly turn off, and when the green power button light on the 
front of the instrument turns off, shut off the pump manually from the rocker switch 
located on the pump.

5.3   Analyzer Restart after Electrical Power Outage
If power to the analyzer is cut-off for any reason the analyzer will cease operation. However, 
when the power is reapplied, the analyzer will restart automatically, the Picarro software 
tools will properly close out previous files and open new files for data collection so that 
previously collected data, instrument diagnostics and other parameters recorded up to the 
time of power outage are retained.

NOTE
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If short power outages are common in the user location, Picarro recommends using an 
uninterrupted power supply (UPS) to protect the data stream and the health of the cavity.

5.4   Picarro Launch Pad
The Picarro Launch Pad is the entry point for starting and using the analyzer. It provides 
access to the CRDS Data Viewer, tools, configuration settings, and administrative controls 
for the instrument such as managing user accounts. This section provides an overview of the 
Picarro Launch Pad’s key features with additional information throughout this manual.

5.4.1 Home Menu
When the analyzer is powered on the Picarro Launch Pad automatically starts and displays 
the Home menu as shown in Figure 13. To manually start the analyzer from the Picarro 
Launch Pad, single click on the NH3 button or wait 30 seconds while the acquisition software 
auto starts and initializes.

Additionally, use the buttons on the Home screen to use the features as shown in the 
following figure. The Files, Config, Service, and Power Off buttons are password protected 
to prevent accidental shutdown or configuration changes. 

Figure 13 - Picarro Launch Pad/Home Menu

The Home menu provides the following options:
 l NH3 — Starts the analyzer in normal operation.
 l NH3 (DCRDS) — Started the analyzer in DCRDS operation. For more information, 

see , DCRDS Mode.
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 l Files — Copies data to an external device (user credentials required). See the 
following , File Manager for more information.

 l Power Off — Performs a soft shutdown (user credentials required).

DCRDS Mode

The DCRDS (Differential CRDS) mode tracks variations in the baseline that are induced by 
changing concentrations of large molecules e.g. volatile organic compounds (VOCs) and 
corrects the resulting spectrum to ensure accurate and precise measurements of the 
targeted molecule, which is NH3 for this analyzer.  Use this mode when expecting frequent 
variations of VOC concentrations in the sample matrix.  Please note, the measurement 
interval slightly increases by ~1 second when using the DCRDS mode.

File Manager

The File Manager is accessible from the Picarro Launch Pad from the Home menu or directly 
from the CRDS Data Viewer Tools menu using the Files button. Follow the procedure to copy 
data to an external drive. 

1. On the home page, click on Files.

2. Login using user credentials. 

3. Plug in an external USB drive.

4. In the bottom right-hand corner, select mount and choose the desired drive. After 
selecting, files are populated on the right side with content from the USB drive.

5. Using the upper left-hand corner drop down menu, select the type of file: Data, 
Screenshot, User History, Validation Report.

6. Highlight and select the desired files.

7. Click Copy to copy or move to transfer file to USB drive.

8. Unmount the USB drive when file transfer/copy is complete.
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Figure 14 - Transfer Files Dialog

5.4.2 Configuration Menu
The Configuration menu provides access to various tools and configuration settings. This 
section describes the Configuration menu’s features and is accessible by performing the 
following procedure.

1. Shut down the data viewer software by clicking the Quit button and allow the analyzer to 
return to atmospheric pressure and stop measurements.

2. From the home screen, click on the Config button to configure the analyzer. 

3. Log in with a user name and password. Note a user account with appropriate access is 
required.
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Figure 15 - The Config Login Dialog

The Configuration Menu displays. 

Figure 16 - Configuration Menu
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If the analyzer is operating in measurement mode, only DataViewer and User options 
are accessible from the Config menu. To access the full menu, restart the analyzer or 
stop measurement mode by selecting Shift key from the keyboard and clicking the 
Quit button from the CRDS Data Viewer.

Network

1. Click the Network button to view the Network Settings Tool. Note requires login.

Figure 17 - Login: Network Settings Tool

The Network Settings Tool displays.

NOTE
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Figure 18 - Network Settings Tool

Use the Network menu to:

 l Select ethernet adapter 
 l Select IP address type
 l If Static IP is selected, enter the applicable address, netmask, gateway, or DNS 

server
 l View the network connection status and active IP address

Clock

Click the Clock button; the Set Time and Time Zone dialog displays.

The time can only be changed when the analyzer has just been turned on from being 
completely off, and before the data acquisition warm-up process begins.

NOTE
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Figure 19 - Clock Set Dialog

Use the Clock dialog to:

 l Set the clock for a new time zone.
 l Manually set the correct time.

Set the Local Time Zone

1. Click on the Local Timezone drop-down and select the location you want. The Local 
Date/Time field changes to the date and time for the location you selected.

2. Click Set to save the changes and return to the Config menu.
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Figure 20 - Clock Set Menu

Manually Set the Time

Use the Set Time Manually check box to manually reset the clock to the correct date and 
time when the clock is set to the wrong time.

1. Check the Set Time Manually check box.

2. Click Set to save the changes and return to the Config menu.
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Figure 21 - Clock Set Dialog

DatViewer

The Data File Viewer software allows concatenating multiple files into one file to provide 
historical trends over a specified time of measurement. For more information, see Chapter A, 
Data File Viewer.

Serial Port

Allows configuration of the ASCII Serial Port by setting the Data Out and Command Interface 
parameters that are used for RS-232 serial communication. For more information, see 
Chapter E, Serial Communication Protocols.

Users

Provides access to the User Management Tool for managing user accounts, security 
settings and user history. Requires a password to obtain entry. For more information, see 
Chapter 7, User Management.

Modbus

Allows configuration of the Modbus communication protocol. For more information, see 
Chapter 9, Modbus Communication.
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Backup Restore

Provides a mechanism for backing up and restoring system settings.

5.4.3 Service Menu
The service menu is password protected and allows for service tasks to be performed by 
trained Picarro personnel only.
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6 List of GUI Functions

The illustrations shown in this chapter are for example only. What is shown on your 
instrument is dependent on the model analyzer in use and may differ.

6.1   GUI Overview
The features of the GUI are described in the following sections.

Users, View, Tools, and Help menus

Digital Readouts and Statistics

Instrument Status (not shown)

Alarm Panel

Quit Button

Data Log, Filename, and Path

Status Log Window

Data Source, Data Key, and Precision 
pull-down menus for data window 
content

Axis Auto Scaling

Reset Data Buffer

Data Buffer Level Meter

Data Windows

Figure 22 - Layout of PI2103 Analyzer GUI

NOTE
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6.2   Users, View, Tools, and Help Menus

Figure 23 - CRDS Toolbar Options

6.2.1 User Menu
Left clicking on the Users menu displays the drop-down User Login or User Logout. 
Depending on your level of access, different menu items are enabled.

6.2.2 View Menu
The View menu provides the following options that can be enabled. Note that when toggled 
on, a checkmark displays to indicate the enabled feature.

 l Lock/Unlock time access when zoomed — When locked, forces the data windows 
to display the same time scale during zoom.

 l Show/hide Statistics — Displays the measurement statistics.
 l Show/hide Instrument Status — Displays the instruments status.

6.2.3 Tools Menu
Use the Tools drop-down menu to plot data, copy data, perform user admin tasks, calibrate 
the instrument, or show/hide the valve sequencer GUI. The Tools menu features are as 
follows:

 l User Administration — Provides access to User Management options for managing 
user accounts, policies, viewing histories and profiles.

 l System Validation with CO2 — Allows an easy and straightforward validation of the 
NH3 measurement accuracy and linearity using CO2 as a surrogate gas.

 l DatViewer — Allows plotting of data saved in *.dat and *.h5 files.
 l Files — Copies data to an external drive using the File Manager.
 l Show Valve Sequencer GUI — Toggle to display the external valve sequencer 

window (use alt-tab to bring it to the front).
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More details on best practices for the surrogate gas validation and the zero-point 
validation are given in our technical guide titled: Rapid Analyzer Validation Using a 
Traceable Surrogate Gas Approach. Following is the link to the document: 
https://www.picarro.com/Surrogate-Gas-Validation

Also, a supplemental surrogate gas validation Excel worksheet can be used in 
conjunction with the above technical guide. Following is the link to the worksheet: 
https://www.picarro.com/Surrogate-Gas-Validation-Worksheet

The link opens the worksheet in your web browser, but the file can be saved to your PC 
for opening in Excel for use.

6.2.4 Help Menu
 l About — Displays the version number of the instrument.

6.3   Alarms Panel
This panel is used to monitor the status of the internal instrument alarms. These indicators 
are gas concentration alarms, such as “NH3 Too High/Low” depending on instrument 
configuration. The gas concentration alarm icons are off (grayed) when the respective 
concentrations are below a certain value, and they are illuminated red when the respective 
concentrations are above/below a certain value. 

High/low alarm settings are not intended as a safety measure as configured at the 
factory, either with respect to human health or the health of the analyzer. It is up to the 
customer to determine the meaning and level of a “high” or “low” value based on their 
application.

NOTE

CAUTION
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Figure 24 - Alarm Panel

Alarm Panel Indicators are colored as follows:

System Alarm:

 l Green when the analyzer is measuring properly
 l Flashing Yellow when the analyzer is warming up
 l Yellow when not warming up properly
 l Red when not operating properly

Measurement Range Alarm:

 l Green when concentration is within analyzer measurement range
 l Red when above analyzer measurement range

Custom Range Alarm:

 l Green when within boundaries set by the user
 l Red when not within boundaries set by the user
 l Grey when alarm is disabled by the user (these are disabled by default)

To view the alarm set points for a gas, click on the indicator next to that gas. The Alarm Set 
dialog displays. 
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Figure 25 - Alarm Set Dialog

This feature allows reading or changing the alarm settings and the ability to enable it or 
change the set point. The indicator illuminates when the concentration goes above the set 
point and resets (indicator off) below the set point. The alarm modes for gasses are:

 l Higher
 l Lower
 l Inside
 l Outside

Type the value you wish to set the alarm to and click the OK button or Cancel if you do not 
wish to change the alarm value. If you do nothing, the dialog box will disappear, and the 
alarm value will remain unchanged. The units are those that appear in the GUI graph. 

6.4   Digital Readouts
Displays the latest value recorded for the selected Data Key for each Data Window. 
Changing the Data Key changes the Digital Readout as well as the Data Window view.

If the Show Statistics entry is enabled in the View menu, the mean, standard deviation, and 
slope of the data in the graph is dynamically calculated and indicated below the digital 
concentration readout. These numbers change to reflect statistics of whatever data is in the 
data window. Zooming into a section of existing data will show the statistics statically for that 
time period, while the digital readout above the statistics continues to update with the latest 
value. See 6.13, Graph Zooming and Panning,  for more information.
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With Show Statistics

Show Statistics Disabled

Figure 26 - Digital Readouts Panel

6.5   Instrument Status
If these parameters are enabled through the Show Instrument Status entry in the View menu 
on the main toolbar, digital readouts for Warm Box temperature, Cavity Temperature, Cavity 
Pressure, and Box Pressure are displayed to the left of the main trend graphs.

Figure 27 - Instrument Status Panel

6.6   Shutdown and Stop User Log(s) Buttons

Figure 28 - Shutdown/Stop User Log

1

2
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6.6.1 Quit Button:
Shuts down the analyzer. See 5.2.2, Shutdown (CRDS Data Viewer).

Figure 29 - Quit Button

6.6.2 Restart User Log(s) Button
The Analyzer automatically records all data collected on the instrument as .dat files. These 
are described further in section Chapter 8, File Management.

To start a new data file (time-coded to the current second), click the Restart User Log(s) 
button. The new file name should be visible beneath the button in a few seconds.

6.6.3 Data Log Filename and Path
The filename and path of the active data log is displayed in this pane. The indicator is grayed-
out when there is no active data log before gas measurement reporting begins. A new file is 
generated when the instrument starts reading gas concentrations, (e.g., “153719”) and 
subsequently at 1-hour increments (e.g., “163719”, “173719”). A new day folder (e.g., 
“2021\07\16”) will be generated at midnight, as will month and year folders at the appropriate 
times.

Figure 30 - Data Log Filename and Path Panel

6.7   Data Window
The data window displays a graph of any stream of data vs. system time, with a format of 
hh:mm:ss. The user can select which data streams are displayed using combinations from 
the Data Source and Data Key pull down menus. The precision displayed can be adjusted 
using the Precision menu. Auto-Scaling of the Y-axis is also available. Clicking any 
Autoscale button autoscales its Y-axis if the plot hasn’t done this automatically.
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Source Keys

Data Keys

Precision Keys

Auto Scale

Reset Buffers

Plot for Data Key 1

Plot for Data Key 2

Figure 31 - Data Window Panel for NH3 and H2O

6.8   Data Source and Data Key Pull Down Menus
Data Source and Data Key menus (Figure 32) enables selection of the data stream that is 
viewed in the data window. 

 l Gas concentrations— If ‘Instrument Analysis’ (where instrument represents the 
system installed) is selected.

 l Sensor Readings — If “Sensors” is selected, the analyzer’s optical cavity pressure 
or temperature can be viewed, as well as the temperature of the electronics of the 
analyzer (“DASTemp”, not directly controlled), and the temperature of the 
analyzer’s wavelength monitor, indicated as “WarmBoxTemp.” 

Figure 32 - Data Source and Data Key Pull Down Menus

1
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6.9   Precision Pulldown Menu
Click on the pull-down to select the precision displayed on the y-axis; between 0 and 4 digits 
of precision or auto. The currently selected precision is displayed during operation. This does 
not affect the precision of the saved data in the data log files or results files. Auto precision is 
sufficient for nearly all applications.

Figure 33 - Precision Pull-down Pane

6.10   Analyzer Status Log
This window displays instrument status messages, in the following form: 
YYYY-MM-DD HH:mm:ss, then ‘Generic message text’.

6.10.1 Common Status Log Messages
Following are the most common messages that appear:

 l Pressure Stabilizing/Locked — Displayed when the valve control system begins to 
allow flow through the analyzer and stabilizes the pressure inside the cavity.

 l Temperature Locked: WB (HB) — When the temperatures of the warmbox 
(wavelength monitor) and hotbox (cavity) have stabilized. 
This is typically the longest step in the startup sequence. Startup: Depending on 
ambient temperature, the analyzer and its hotbox temperature set point, this step 
may take as little as 20, or as much as 60 minutes. Restart: If the instrument is only 
stopped briefly, this may take a few seconds to a few minutes.

 l Preparing to Measure — Spectral scanning has started. Concentration 
measurements will be available in approximately 30 seconds. The instrument will 
continue to scan and report concentration measurements until the instrument is 
shut down.

 l Measuring — This is the normal mode of operation after startup has completed.

Figure 34 - Analyzer Status Log
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6.11   Data Buffer Level Meter
The meter to the right of the Data Window (Figure 35) indicates how much of the internal 
memory of the GUI is used to retain historical data collected with the instrument. There is an 
internal limit of a finite number of points. Once that number of data points is collected, the 
buffer is full, and old data is removed from the buffer as new data is collected. This buffer 
affects only the data displayed in the data window, not the data stored in any files. This buffer 
is empty upon instrument startup and can also be emptied by pressing the Reset buffers 
button in the lower-right-hand corner of the GUI.

Figure 35 - Data Buffer Level Meter and Reset Buffers Button

6.12   Reset Buffers Button
Click the Reset Buffers button to clear the internal data buffer of the GUI (this clears the 
current data traces from the graphs). This has the effect of clearing all data in the data 
window. Pressing this button has no effect on any of the data log files stored by the 
instrument.

6.13   Graph Zooming and Panning
To zoom in on a specific region of the graph, move the cursor to the area of interest, 
click/hold the left mouse button, then drag as desired to create a box that covers the region 
of interest (Figure 36). When the box is drawn, release the left button and the boxed area will 
automatically scale to fill the data window. 
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Figure 36 - Data Graph Zoom Function

 l To zoom back out to see all data in the buffer — Use the left button and double-
click  within the graph display.

 l  To zoom out indefinitely — Click the right button. Right clicking multiple times 
zooms out further.

 l To auto scale the y-axis of either graph — Use the Auto-Scale buttons below the 
graph as shown in Figure 37.

 l To Zoom the X and Y axes — Hold down the control button and move the cursor 
up/down or left/right using the right mouse button

Top Plot

Bottom Plot

Figure 37 - Auto-scale Buttons

6.13.1 Lock/Unlock Time Axis
Zoom and pan features are often useful when time axes are locked, and the user wishes to 
align the Y axis in multiple plots. To lock or unlock the time axis of each graph during 
zooming, from the View menu, select Lock time axis when zoomed or Unlock time axis.

6.13.2 Panning
To pan the data in the X or Y axis: hold down the control button and drag the cursor using 
the left mouse button.

1

2
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7 User Management
User management includes:

 l Managing user accounts, such as adding users and changing passwords.
 l Setting user policies, such as password requirements and session duration.
 l Viewing and saving user histories.

There are three user roles defined in the system: operator, technician, and administrator. The 
permissions are as follows:

Table 5 - User Accounts/Functions

Function
Not Signed 

In
Operator Technician Administrator

View Data Viewer x x x x

Set Alarms   x x x

Configure Data Viewer 
(partial) 

  x x x

Quit Measuring   x x x

Quit (software shutdown)   x x x

Configure Data Viewer (full 
access)

      x

User Management       x

User management settings are available from the Tools menu in the Data Viewer or by using 
the Picarro Launch Pad. Use one of the following procedures.

From the Data Viewer:

1. From the Users menu, select User Login.

2. Login as an administrator (default user name is admin; default password is admin).

3. From the Tools menu, select User Administration to view the User Management as 
shown in Figure 38.
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From Picarro Launch Pad:

1. Select the Config and Users button.

2. From the User Management Tool login as an administrator (default user name is admin; 
default password is admin).

3. The User Management window displays with the following tabs: 
User Accounts, User Policies, and User History.

Figure 38 - User Management/User Accounts Tab

7.1   Managing User Accounts
The following features are available from the User Accounts tab and are described in this 
section:

 l Change user passwords
 l Change user roles
 l Disable users
 l Add new users
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The default user names that are provided with the analyzer are tech, operator, and 
admin. The default passwords are tech, operator, and admin, respectively. User names 
and passwords are both case sensitive.

7.1.1 Changing a User Password
1. In the User Management window, click the User Accounts tab.

From the list of users, click the user you want to change and select the Change Pwd 
button. The user account information displays

2. In the New Password field, enter the new password.

Passwords are case sensitive. Additional rules for passwords can be set in the User 
Policies tab. For more information, see 7.2, Setting User Policies.

Figure 39 - Change Password

3. In the Confirm Password field, re-enter the password.

4. Click Next to save the password.

7.1.2 Changing a User’s Role
1. In the User Management window, click the User Accounts tab.

2. From the list of users, click the user you want to change.

3. From the Change Role drop-down, select the new role and click Ok when prompted.

NOTE
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The role is now changed to the desired setting.

Figure 40 - Change Roles

7.1.3 Disabling a User Account
Users cannot be deleted from the system, but they can be disabled to prevent access to the 
software. See Figure 41 for more information.

1. In the User Management window, click the User Accounts tab.

2. From the list of users, click a user name. 

3. Click Disable User; this will prompt you to confirm your choice.

4. Click OK to confirm the action.
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Figure 41 - Disable Users

7.1.4 Adding a User
1. In the User Management window, click the User Accounts tab.

2. Click Add User; this displays the Add User screen.

Figure 42 - Add User
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3. Fill in the fields in the Add User window.

4. Click Next to open the New User Account dialog.

5. Review the user information and click OK to accept or Cancel to go back and edit the 
information.

7.2   Setting User Policies
1. In the User Management window, click the User Policies tab.

2. Make any changes. For more information, see the following 7.2.1, User Policy 
Descriptions.

3. Click Save. If you typed an incorrect value and want to undo any changes and revert 
back to the last saved configuration, click Revert.

Figure 43 - User Policies Tab
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7.2.1 User Policy Descriptions
The following table provides descriptions for the various user policies.

Table 6 - User Policies

Policy Description

Password 
length

Specify that the length of passwords (6–15 characters) or turn off the length 
requirement.

Password 
complexity

When selected, all new passwords must have at least one number, one 
letter, and one special character. This will not impact existing passwords.

Password 
expiration

When selected, any passwords that reach the selected maturity will expire. 
Any user signing in with an expired password will be required to create a 
new password.

Previous 
passwords 

When set, prevents a user from reusing a recent password. The system can 
remember up to 10 old passwords.

Limit login 
attempts

Tell the system to disable a user account after a set number of failed 
password attempts. The failed attempts are counted until the user 
successfully logs in. Once disabled, an admin will have to enable the 
account.

Lock 
session

When set, the system will automatically logoff any user after a set period of 
inactivity, requiring the user to sign in again.

Change 
password

Allows the user to change their own password.

Change 
phone 
number

Allows the user to change phone number and restrictions.

Change 
email

Allows user to change their email address.

Change 
name

Allows the user to change first and last name.

Save user 
actions

When enabled, user actions (such as logging in) will be saved in the User 
History.
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7.3   Viewing User History
1. In the User Management window, click the User History tab to see a list of all the logged 

events.

Figure 44 - User History Tab

2. Click the < and > buttons to navigate through the history (if the button is grayed out, then 
there are no additional pages).

3. To make sure the content is up to date, click Refresh.

4. To copy the user history onto a USB drive, click Download. This laucnhes the File 
Manager, which will prompt to login. See File Manager on page 37 for details on copying 
files from the analyzer.
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8 File Management
The analyzer generates ASCII-format text output files. The data files are created every 60 
minutes by default.

The file name is generated from the analyzer serial number, the date, and the time when the 
analyzer was started. For example:

Figure 45 - Example Data File Name

SADS2001-20160127-1029-DataLog_User_Raw.dat
 l SADS2001 — The analyzer's serial number.
 l 20160127 — The date, 1/27/2016, in format yyyymmdd (to allow chronological 

sorting of data files).
 l 1029 — Time the file was started in GMT, 10:29 am, formatted as hhmm using a 24-

hour clock.

The raw user data is contained in folders in the directory: 
 l /home/picarro/si2000/userdata/datalog_user/year/month/day/hour for data 

sampled at the analyzer’s native sampling rate
 l /home/picarro/si2000/userdata/datalog_sync/year/month/day/hour for data 

sampled at the analyzer’s native sampling rate

Data files are created every 60 minutes and stored for 90 days (default for SADs analyzers) 
before they are automatically deleted. File deletion frequency and details can be modified in 
the file: /home/picarro/si2000/appconfig/config/archiver/archiver.ini.

During data acquisition, the analyzer creates directories to store the data, filed by the date 
the data were acquired.

The following figure shows a partial example of a data file.

Figure 46 - Data File
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Datafiles are closed every 60 minutes and moved to an archive directory and a new datafile is 
started.

The archive directory is /home/picarro/si2000/log/archive and has subdirectories datalog_
mailbox, datalog_private and datalog_eventlogs with files arranged by 
year/month/day/hour.

There are more complete data files which include additional information beyond the 
concentration data including parameters such as analyzer temperatures and pressure, 
setpoints and spectroscopic information. This information is generally not useful to the user 
but can be useful for diagnostic purposes and is store in the directory 
/home/picarro/si2000/log/archive/datalog_private /year/month/day/hour.

For more information about how to include various columns of data from the datalog_private 
in the /home/picarro/si2000/userdata datalog files, contact Picarro.

The currently active data file can be found in /home/picarro/si2000/log/datalogger.

Archive directory contain subdirectories arranged by file type and internally organized by 
/year/month/day/hour. 

To keep the data files easy to manage and to limit the size of individual files and directories, 
new files are automatically generated whenever the analyzer is operating.

The software automatically generates new files each time the analyzer is powered up and 
also at midnight (GMT) each night. When new files are created at midnight, their file name will 
contain the new date and a time of 00:00.

For example, if the system was started at 10:29 am on 2/5/2016 it would create a file named 
20160205/sads2001-20160205-1029-userlog.dat. Then at midnight a new file will be 
created sads2001-20160206-0000-userlog.dat.
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9 Modbus Communication
Modbus is a client/server data communication protocol to support communication to and 
from multiple devices connected to the same cable. Modbus can be configured for TCP/IP 
on port 50500 or RTU utilizing the analyzer’s COM1 port. See the following section on how to 
configure Modbus communication. 

9.1   Configuring Modbus Communication
1. From the Picarro Launch Pad, select Config followed by the Modbus button to configure 

the Modbus server as shown in the following figure.

Note the Config menu requires login to access the configuration menu. Log in with a 
user name and password.

Figure 47 - Settings/Modbus Configuration

This displays the Modbus Settings window shown in Figure 48. 

NOTE
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Figure 48 - Modbus Settings Window

2. From the Modbus Settings window the following configuration options are available:
 l Slave ID — The analyzer’s Slave ID.
 l Modbus Type — The Modbus Communication Protocol: TCP/IP or RTU. For more 

information, see section 9  Modbus Communication.
 l TCP Port — Designates the TCP port if TCP/IP is selected.

Additionally, the window displays the CommandInterface Status. However, if Modbus 
Type is set to RTU, then the CommandInterface on COM 1 is disabled.

9.2   Modbus Data Registers Overview and Setup
This section describes the basic types of MODBUS data registers and setup information. 

Table 7 - MODBUS Register Types

Name Size Access

Input Register 16 bits Read-only

Holding Register 16 bits Read-write

Discrete Input 1 bit Read-only

Coils 1 bit Read-write
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9.2.1 Modbus TCP Setup Notes
 l MODBUS is configured for TCP/IP on port 50500.
 l When MODBUS is configured on port 50500, communication is also possible via 

port 502.
 l If MODBUS is configured as TCP/IP and the IP address of analyzer is changed, the 

user needs to restart the host application to run MODBUS with the updated IP 
address. 

 l MODBUS over TCP/IP does not support privileged ports (0 to 1023), except for port 
502.

9.2.2 Modbus RTU Setup Notes
 l MODBUS RTU uses the analyzer’s COM1 port.
 l To establish connection between master and slave over MODBUS RTU, user needs 

to establish connection using "Straight Through Cable”. 
 l When MODBUS is configured for RTU, CommandInterface on COM1 is disabled. 

9.3   Modbus Register Maps
 l Data returned is in big endian format if it utilizes more than one Modbus register. 
 l If input register functionality is not available for a given analyzer type, the instrument 

will return value as “NaN” for float values and “False” for 1-bit registers.
 l Memory map is continuous memory. If a user tries to read a register address for 

which functionality is not available, it will return “0”. For example, reading address 
“0” for coil registers returns “0” since the address does not exist.

 l If a user tries to read a register address outside of maximum register memory map, 
the request will return an exception. For example, reading address 156 for coil 
register will return exception code “0x02” (Illegal address). 

 l System time is in milliseconds since 0001-01-01 AD.

9.4   Input Register Map
Most of the readings in Picarro analyzer are the float type and need 32-bit data. Each 
parameter utilizes two registers, out of which the first one stores the MSB and the second 
stores the LSB of the float number.

Table 8 - Input Registers

Address Description Units Type Comments

0-5 Time stamp   String
Long value return as 12 byte 
string. Date format: 
YYMMDDHHMMSS
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Address Description Units Type Comments

6-7
Concentration of 
measured gas # 1, 
NH3

ppb Float
The identity of this gas varies with 
analyzer. However, register 6 is 
always gas # 1

8-9 Gas # 1 ID Unitless Float Gas #1 ID = 1, NH3

10-11
Gas #1, 30 sec 
trailing average

ppb Float  

12-13
Gas #1, 2 min 
trailing average

ppb Float  

14-15
Gas #1, 5 min 
trailing average

ppb Float  

16-17
Gas #1, max (full 
scale range)

ppm Float  

18-19 Gas #1, min (MDL) ppm Float  

20-21
Concentration of 
measured gas #2, 
H2O

ppb Float
The identity of this gas varies with 
analyzer, however register 20 is 
always gas # 2

22-23 Gas #2 ID Unitless Float Gas #2 ID = 0, H2O

24-25
Gas #2, 30 sec 
trailing average

ppb Float  

26-27
Gas #2, 2 min 
trailing average

ppb Float  

28-29
Gas #2, 5 min 
trailing average

ppb Float  

30-31
Gas #2, max (full 
scale range)

ppm Float  

32-33 Gas #2, min (MDL) ppm Float  

34-35
Concentration of 
measured gas #3, 
CO2

ppb Float
The identity of this gas varies with 
analyzer. However, register 34 is 
always gas # 3

36-37 Gas #3 ID Unitless Float Gas #2 ID = 3, CO2
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Address Description Units Type Comments

38-39
Gas #3, 30 sec 
trailing average

ppb Float  

40-41
Gas #3, 2 min 
trailing average

ppb Float  

42-43
Gas #3, 5 min 
trailing average

ppb Float  

44-45
Gas #3, max (full 
scale range)

ppm Float  

46-47 Gas #3, min (MDL) ppm Float  

48-49
Concentration of 
measured gas #4, 
N/A

ppb Float
The identity of this gas varies with 
analyzer. However, register 48 is 
always gas # 4

50-51 Gas #4 ID Unitless Float
N/A; PI2103 only reports 3 gases 
over MODBUS

52-53
Gas #4, 30 sec 
trailing average

ppb Float  

54-55
Gas #4, 2 min 
trailing average

ppb Float  

56-57
Gas #4, 5 min 
trailing average

ppb Float  

58-59
Gas #4, max (full 
scale range)

ppm Float  

60-61 Gas #4, min (MDL) ppm Float  

62-63
Concentration of 
measured gas #5, 
N/A

ppb Float
The identity of this gas varies with 
analyzer. However, register 62 is 
always gas # 5

64-65 Gas #5 ID Unitless Float
N/A; PI2103 only reports 3 gases 
over MODBUS

66-67
Gas #5, 30 sec 
trailing average

ppb Float  
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Address Description Units Type Comments

68-69
Gas #5, 2 min 
trailing average

ppb Float  

70-71
Gas #5, 5 min 
trailing average

ppb Float  

72-73
Gas #5, max (full 
scale range)

ppm Float  

74-75 Gas #5, min (MDL) ppm Float  

76-77
Concentration of 
measured gas #6, 
N/A

ppb Float
The identity of this gas will vary 
analyzer to analyzer, but Reg 76 is 
always gas # 6

78-79 Gas #6 ID Unitless Float
N/A; PI2103 only reports 3 gases 
over MODBUS

80-81
Gas #6, 30 sec 
trailing average

ppb Float  

82-83
Gas #6, 2 min 
trailing average

ppb Float  

84-85
Gas #6, 5 min 
trailing average

ppb Float  

86-87
Gas #6, max (full 
scale range)

ppm Float  

88-89 Gas #6, min (MDL) ppm Float  

90-91
Concentration of 
measured gas #7, 
N/A

ppb Float
The identity of this gas varies with 
analyzer. However, register 90 is 
always gas # 7

92-93 Gas #7 ID Unitless Float
N/A; PI2103 only reports 3 gases 
over MODBUS

94-95
Gas #7, 30 sec 
trailing average

ppb Float  

96-97
Gas #7, 2 min 
trailing average

ppb Float  
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Address Description Units Type Comments

98-99
Gas #7, 5 min 
trailing average

ppb Float  

100-101
Gas #7, max (full 
scale range)

ppm Float  

102-103 Gas #7, min (MDL) ppm Float  

104-105
Concentration of 
measured gas #8, 
N/A

ppb Float
The identity of this ga varies with 
analyzer. However, register 104 is 
always gas # 8

106-107 Gas #8 ID Unitless Float
N/A; PI2103 only reports 3 gases 
over MODBUS

108-109
Gas #8, 30 sec 
trailing average

ppb Float  

110-111
Gas #8, 2 min 
trailing average

ppb Float  

112-113
Gas #8, 5 min 
trailing average

ppb Float  

114-115
Gas #8, max (full 
scale range)

ppm Float  

  Gas #8, min (MDL) ppm Float  

Sections 200-298 is for public sensor data

200-201 Cavity Pressure Torr Float  

202-203
Cavity 
Temperature

deg C Float  

204-205 DAS Temperature deg C Float  

206-207
Etalon 
Temperature

deg C Float  

208-209
Warm Box 
Temperature

deg C Float  
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Address Description Units Type Comments

210-211 Outlet Valve
dig 

counts
Float  

212-213
Instrument cal 
slope, gas #1, 
NH3

  Float  

214-215
Instrument cal 
offset, gas #1, 
NH3

  Float  

216-217

User cal slope, 
gas #1,

NH3

  Float  

218-219
User cal offset, 
gas #1, NH3

  Float  

220-221
Instrument cal 
slope, gas #2, 
H2O 

  Float  

222-223
Instrument cal 
offset, gas #2, 
H2O 

  Float  

224-225
User cal slope, 
gas #2

  Float  

226-227
User cal offset, 
gas #2, H2O 

  Float  

228-229
Instrument cal 
slope, gas #3, 
CO2

  Float  

230-231
Instrument cal 
offset, gas #3, 
CO2

  Float  

232-233
User cal slope, 
gas #3, CO2

  Float  
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Address Description Units Type Comments

234-235
User cal offset, 
gas #3, CO2

  Float  

236-237
Instrument cal 
slope, gas #4, N/A

  Float  

238-239
Instrument cal 
offset, gas #4, N/A

  Float  

240-241
User cal slope, 
gas #4, N/A

  Float  

242-243
User cal offset, 
gas #4, N/A

  Float  

244-245
Instrument cal 
slope, gas #5, N/A

  Float  

246-247
Instrument cal 
offset, gas #5, N/A

  Float  

248-249
User cal slope, 
gas #5, N/A

  Float  

250-251
User cal offset, 
gas #5, N/A

  Float  

252-253
Instrument cal 
slope, gas #6, N/A

  Float  

254-255
Instrument cal 
offset, gas #6, N/A

  Float  

256-257
User cal slope, 
gas #6, N/A

  Float  

258-259
User cal offset, 
gas #6, N/A

  Float  

260-261
Instrument cal 
slope, gas #7, N/A

  Float  

262-263
Instrument cal 
offset, gas #7, N/A

  Float  
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Address Description Units Type Comments

264-265
User cal slope, 
gas #7, N/A

  Float  

266-267
User cal offset, 
gas #7, N/A

  Float  

268-269
Instrument cal 
slope, gas #8, N/A

  Float  

270-271
Instrument cal 
offset, gas #8, N/A

  Float  

272-273
User cal slope, 
gas #8, N/A

  Float  

274-275
User cal offset, 
gas #8, N/A

  Float  

386 Error code   Integer

Error for each control command of 
COIL. 

NO_ERROR = 0

ERROR_HANDLER_ERROR = 1

ERROR = 2

NO_SUDO_USER_PRIVILEGE = 3

NO_USER_EXIST = 7

USERNAME_PASSWORD_
INCORRECT = 9

USER_DISABLED = 10

ADMIN_RIGHT_REQUIRES = 11

PASSWORD_LENGTH_ERROR = 
12

PASSWORD_FORMATE_ERROR 
= 13

PASSWORD_REUSE_ERROR = 
14
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Address Description Units Type Comments

387
Measurement 
status 

  Integer

ledState = 0 red, system error, gas 
concentration measurements 
invalid

ledState = 1 solid yellow, need 
service, gas concentration. 
measurements might be OK

ledState = 2 blinking yellow, not in 
reporting mode by system OK, 
like during warmup

ledState = 3 green, system OK, 
gas concentration measurements 
accurate

9.5   Discrete Input Register Map
The following table describes the discrete input registers. Please note the following:

 l All data unit are unitless unless otherwise noted. 
 l All data types are floats unless otherwise noted.
 l All unused addresses are reserved. 

Table 9 - Discrete Input Registers

Address Description Units Comments

5 Pressure locked    

6 Cavity temperature locked    

7 Warm box temperature locked    

72 Incomplete spectrum for gas #1    

73 Incomplete spectrum for gas #2    

74 Incomplete spectrum for gas #3    

75 Incomplete spectrum for gas #4   Not used

76 Incomplete spectrum for gas #5   Not used

77 Incomplete spectrum for gas #6   Not used



9 Modbus Communication

84 PN 40-0120, REV B PI2103 User Manual

Address Description Units Comments

78 Incomplete spectrum for gas #7   Not used

79 Incomplete spectrum for gas #8   Not used

80 Bad baseline for gas #1    

81 Bad baseline for gas #2    

82 Bad baseline for gas #3    

83 Bad baseline for gas #4   Not used

84 Bad baseline for gas #5   Not used

85 Bad baseline for gas #6   Not used

86 Bad baseline for gas #7   Not used

87 Bad baseline for gas #8   Not used

88 Degraded performance for gas #1    

89 Degraded performance for gas #2    

90 Degraded performance for gas #3    

91 Degraded performance for gas #4   Not used

92 Degraded performance for gas #5   Not used

93 Degraded performance for gas #6   Not used

94 Degraded performance for gas #7   Not used

95 Degraded performance for gas #8   Not used

9.6   Holding Register Map 
The following table describes the holding registers. 

Table 10 - Holding Registers

Address Description Type Comments

0-3 System time Integer
Integer representing milliseconds from 1AD 
January 1st to now
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Address Description Type Comments

4-7 Username String  

8-11 Password String  

200-201 User data 1 Float  

202-203 User data 2 Float  

204-205 User data 3 Float  

206-207 User data 4 Float  

208-209 User data 5 Float  

210-211 User data 6 Float  

212-213 User data 7 Float  

214-215 User data 8 Float  

216-217 User data 9 Float  

218-219 User data 10 Float  

220-221 User data 11 Float  

222-223 User data 12 Float  

224-225 User data 13 Float  

226-227 User data 14 Float  

228-229 User data 15 Float  

230-231 User data 16 Float  

232-233 User data 17 Float  

234-235 User data 18 Float  

236-237 User data 19 Float  

238-239 User data 20 Float  
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9.7   Coil Register Map

Table 11 - Coil Register Map

Address Description Comments

115 Quit host application  

116 Shutdown instrument Takes approximately 2 min to shutdown

150 Get system time After this read Sync Time holding register

153 User login 
Note before executing this command, user need to 
set user name and user password holding register

154
Update user 
password 

Before executing this command follow the steps

 1. Login as admin using User Login 
functionality

 2. Set user name and password by using 
holding register

155 User logout  

200 Get user data 1  

201 Set user data 1  

202 Get user data 2  

203 Set user data 2  

204 Get user data 3  

205 Set user data 3  

206 Get user data 4  

207 Set user data 4  

208 Get user data 5  

209 Set user data 5  

210 Get user data 6  

211 Set user data 6  

212 Get user data 7  
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Address Description Comments

213 Set user data 7  

214 Get user data 8  

215 Set user data 8  

216 Get user data 9  

217 Set user data 9  

218 Get user data 10  

219 Set user data 10  

220 Get user data 11  

221 Set user data 11  

222 Get user data 12  

223 Set user data 12  

224 Get user data 13  

225 Set user data 13  

226 Get user data 14  

227 Set user data 14  

228 Get user data 15  

229 Set user data 15  

230 Get user data 16  

231 Set user data 16  

232 Get user data 17  

233 Set user data 17  

234 Get user data 18  

235 Set user data 18  

236 Get user data 19  
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Address Description Comments

237 Set user data 19  

238 Get user data 20  

239 Set user data 20  
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10 Troubleshooting
The following section lists problems that may be encountered during installation and 
operation of the analyzer. The corresponding step-by-step procedures provide resolution in 
most cases. If, after attempting these procedures, the problem remains unresolved, please 
contact Picarro Customer Support at +1 408 962 3991 (US) or +31 85 888 1650 
(International) or support@picarro.com.

10.1   Power LED on Analyzer Does Not Illuminate
Context: Turning on the analyzer by momentarily depressing its front panel power switch 
should apply power. The green power LED is illuminated when it detects the correct power 
levels.

1. Check that the AC power cord is attached and plugged into a working outlet.

2. Check that the rear on-off switch near the AC power cord is in the ON position ( I ).

3. Press and hold the front panel power switch for at least 5 seconds as the analyzer may 
take several seconds to respond.

10.2   Sample Pressure not Controlled to Appropriate Value for 
Concentration Measurements
Context: Under normal operation, the cavity pressure is automatically locked to the correct 
value by means of electronically controlled inlet and outlet valves. The message “Pressure 
Locked” on the front panel display and the user interface indicates that the cavity pressure is 
at the appropriate value. Should either of the messages “Pressure high” or “Pressure low” be 
displayed, the cavity pressure is out of its correct operating range. 

 1. Pressure low — Indicates that there is insufficient gas available at the inlet of the 
analyzer. Check the inlet plumbing to the analyzer and ensure that the pressure at 
the inlet is within the specifications. Check for blockages in the lines, or regulators 
that are turned off, especially by removing all items upstream of the inlet to see if the 
pressure returns to the spec. If removing plumbing from upstream of the instrument 
inlet doesn’t work, the inlet particulate filter may need to be replaced. See Chapter 
11, Maintenance for more information.

 2. Pressure high — Indicates that gas cannot be removed from the analyzer at a 
sufficient rate. Check the vacuum line between the analyzer and the power vacuum 
unit for leaks. Failure of the vacuum pump, injecting dilution gas at excessive 
pressure, or excessive pressure at the inlet can also cause this problem

mailto:support@picarro.com
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11 Maintenance
The advanced, rugged design of Picarro Analyzers provides stable, long-term operation with 
minimal service or maintenance. With the exception of the following items, the analyzer and 
pump are not user serviceable. Should either appear to malfunction, please refer to the 
Troubleshooting Guide or contact Picarro Support. 

As described below, users may obtain preventive maintenance components as part of a 
service plan, as part of a designated PM kit, or individually from the Picarro store. 

11.1   Service Plans
In addition to basic telephone and email support and remote diagnostics, service plans 
include an annual preventive maintenance kit and can be purchased by contacting 
sales@picarro.com. The three service plans are as follows:

 l W3101 Essential Service Plan — Free yearly maintenance kit; 50% discount on 
Field Replaceable Parts; 10-20% Discounted factory repair. See data sheet for 
complete terms and conditions. 

 l W3102 Premium Service Plan — Free yearly maintenance kit; Extended warranty; 
Free factory repair; Free Field Replaceable Parts. See data sheet for complete 
terms and conditions.

 l W3103 Commercial Service Plan — Free yearly maintenance kit; Extended 
warranty; Free factory repair; Free Field Replaceable Parts; Loaner instrument; Free 
yearly prevention maintenance visit; Complimentary remote refresher training. See 
data sheet for complete terms and conditions.

11.2   Preventive Maintenance Kits
Preventive maintenance kits can be purchased by contacting support@picarro.com. The 
maintenance kits all include the following elements:

Replacement CPU Fan; particulate filter (Stainless Steel or Teflon); dust filter; replacement 
screws for instrument cover panels; Ball-Point Hex L-Keys; Anti-Static Wrist Strap.

The kits come in three forms depending on the instrument being serviced.
 l S3092 — Yearly Maintenance Kit for GHG, L2xxx, and EtO
 l S3093 — Yearly Maintenance Kit for PI2114
 l S3094— Yearly Maintenance Kit for HAPs G2xxx User-Replaceable Hardware
 l S2179 — Particulate Filter Preventative Maintenance Kit, SI/PI2XXXX Analyzers

mailto:sales@picarro.com
mailto:support@picarro.com
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11.3   User-replaceable Hardware – Individual Components

11.3.1 Particulate Filter
The inlet particulate filter is user-replaceable. Use the following link to order replacements 
and to find the instructional video and supporting maintenance document.

 l Stainless Steel Filter — For all models except those that measure HF, NH3, CH2O, 
HCl and H2O2):
S1020 Particulate Filter Kit — If viewing this manual as a paper hard copy, enter the 
following URL in your browser:
http://store.picarro.com/For — Analyzer/Parts/Particulate-filter-kit-all-models-
except-HF-NH3.html

 l Teflon Filter: For models that measure NH3, HF, CH2O, HCl and H2O2:
S1021 Particulate Filter Kit — If viewing this manual as a paper hard copy, enter the 
following URL in your browser:
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3

 l For a video or step-by-step procedures:
 l Replacing Your Inlet Particulate Filter (instructional video): or visit: 

https://www.picarro.com/videos/replacing_your_inlet_particulate_filter
 l Inlet Particulate Filter Replacement (maintenance Guide): or visit: 

https://www.picarro.com/support/documents/inlet_particulate_filter_
maintenance_guide

11.3.2 CPU Fan
The analyzer CPU fan is user-replaceable and is available per the following service kit:

CPU Fan for MI990 Motherboards

 l S3267: PI5000 CPU Fan Replacement Kit. Includes the S3263 (CPU Fan) and 
required tools for replacement.

11.3.3 A2000 Pump Rebuild Kit
The pump rebuild kit is the only component not currently sold as part of a preventive 
maintenance kit because the replacement frequency is not strictly annual (frequency 
depends on pump usage). 

The A2000 pump diaphragms and valves are user-replaceable. Use the following link to 
order rebuild kits and to find the instructional video and supporting maintenance document.

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3
https://www.picarro.com/videos/replacing_your_inlet_particulate_filter
https://www.picarro.com/support/documents/inlet_particulate_filter_maintenance_guide
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 l Pump Rebuild Kit: Used with SI2xxx, G2xxx analyzers (except Flight and Flux 
analyzers)
S2009 Rebuild Kit for A2000 Vacuum Pump – If viewing this manual as a paper 
hard copy, enter the following URL in your browser:
http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-
vacuum-pump.html

11.3.4 A0702 Pump Rebuild
The A0702 recirculation pump (if used with your analyzer) is not user serviceable. Instead, 
these pumps may be exchanged once they reach the end of their diaphragms’ operational 
life. Please contact support@picarro.com to coordinate this exchange.

11.4   Cleaning
Clean the outside of the analyzer with a clean dry cloth. Only certified service technicians 
should access or clean the inside of the analyzer.

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-vacuum-pump.html
mailto:support@picarro.com


12 Transportation and Storage

PI2103 User Manual PN 40-0120, REV B 93

12 Transportation and Storage
If the analyzer is transported or stored, use the following procedure to prepare and repack it 
into the original packaging.

When shipping or relocating the analyzer, it is important to protect it from mechanical 
shocks. Failure to do so can compromise its performance. When shipping the analyzer, 
use its original packaging only.

12.1   Shutdown and Preparation

A flow of clean, relatively dry gas should always be directed to the instrument for several 
minutes prior to shutting down. Trapping a high-moisture content gas sample in the 
cavity can cause condensation damage to the mirrors as the instrument cools from its 
operating temperature. See 5.2, Shutdown , for specific shutdown instructions for your 
model analyzer.

1. Click on the Quit button located on the left side of the Data Viewer window.

2. A window displays prompting the user to confirm the shutdown. Click Yes to continue 
the shutdown process.

Figure 49 - Stop Data Acquisition/Shutdown

3. Confirm the level of water vapor prior to shutdown. Click No, if the analyzer was dried 
before shutdown. Click Yes, if the analyzer requires dry gas to reduce the moisture 
content.

CAUTION

CAUTION
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Figure 50 - Reduce Moisture Content/Shutdown

Once confirmed, the analyzer software and hardware will turn off.

4. Manually turn off the pumps and dry gas (if used).

5. Disconnect all tubing and electrical connections from the analyzer.

6. To prevent contamination and possible damage to the connector threads, place 
protective caps on all gas connections.

12.2   Packing
1. Place the analyzer in a plastic bag with a package of desiccant.  Seal the bags with tape. 

If shipping the pump, do the same for it.

2. Pack the analyzer and pump in the original shipping containers ensuring that all the foam 
pieces are in place to protect the analyzer during shipping.
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A Data File Viewer

A.1   Quick Start Guide
The following sections introduce the user to all possible functionalities of the Data File Viewer 
in detail. This section describes the most common, simple use case.

The Data File Viewer software allows the user to concatenate multiple one-hour files into one 
larger file, enabling the user to observe trends over several days of measurements.

1. To start, translate the UserData files from DAT to H5. The Batch Convert option (B) 
allows users to select any folder containing instrument data from a given day.

Figure 51 - Batch Convert DAT to H5 – Navigation

2. In the source folder there are now copies of the original files translated into the H5 format. 

3. From File menu select Concatenate H5 Files (C) to combine the H5 files into a time 
series. Take care to select exactly the same folder in the file viewer window.

4. In the Select Variables window, click All to move over all variables for concatenation. 
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If concatenating large records, the user can instead select only a few variables by clicking 
the variable name on the left dialogue and clicking the double arrow button. Confirm by 
clicking OK.

Figure 52 - Selecting Variables for Concatenation

5. The user will then be asked to confirm the file name for the concatenated data. The 
default location is the parent folder for the selected day, and the filename by default 
describes the time span of the measurements within. Successful concatenation is 
indicated by the filename automatically being displayed in the main data file viewer 
window as shown in below.
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Figure 53 - Concatenated Output .h5 Filename

You can concatenate several days into one larger file, either by following steps 1-3 
for selected folders, or by copying all their DAT files into a new folder and performing 
steps 1-5 one time.

6. With the file now opened, the user can select how many Time Series to display on the 
screen.

Figure 54 - Time Series Selection Options

7. In the new window that displays, select the variables from the Var Name dropdown on 
the right of each plot. Deselect Autoscale y if the data stream has a large amount of 
variability in the Y-axis.

NOTE
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Please read the following sections to learn more about features of the Data File Viewer.

A.2   Data File Viewer Overview
The Picarro Data File Viewer software is located from the Picarro Launch Pad,  Home menu. 
This software allows you to graph and to conduct statistical analysis of the raw data. 
Additional functions include Allan Variance plot and quadratic or polynomial fittings. The 
Picarro Data File Viewer includes two main menus: File and New (Figure 55, Figure 56). 

Figure 55 - Picarro Data File Viewer – File Menu

A.3   File Menu
This section describes the functions available from the Data File Viewer File menu.

A.3.1 Open File
File > Open File — Opens a Picarro data file (HDF5 format) for data analysis and 
visualization. After opening the data file, you can create a new time series plot. Refer to A.5, 
New – Time Series Plot  for more information.

A.3.2 Load Config
File > Load Config — Loads a configuration file (.ini format) to restore parameters of a 
workplace. Refer to A.6.2, Save Configuration for more information.

A.3.3 Unpack Zip File
File > Unpack Zip File — Use to concatenate all H5 files inside the zip file into a single H5 file. 
Refer to Concatenate H5 Files below for details.
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A.3.4 Concatenate H5 Files
File > Concatenate H5 Files — Use to concatenate multiple files and zip archives of H5 files 
into a single H5 file. Navigate to the desired folder or use the Define Date Range button to 
specify a date range of files to concatenate. See next section, Define Date Range for more 
information.

After selecting the path of the data files, Data File Viewer will automatically search an H5 file 
in the specified zip/folder and look for all available variables in the H5 file. The variables are 
then listed in the Select Variables window in the left panel (Figure 57), and users can use the 
>> button to move variables to the right panel for concatenation. 

A.4   New Menu
Use the New menu to create a time series plot up to three frames.

Figure 56 - Picarro Data File Viewer – New Menu

Figure 57 - Select Variables Form
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This screenshot is for example only. The species selections shown on your analyzer may 
vary. 

A.4.1 Define Date Range
Data File Viewer can search data files within the desired date range and then concatenate 
such files into an H5 file.

By default, TimeZone is set to your local time zone. However, if data were taken elsewhere, 
select the time zone where data was taken.

Select File > Concatenate H5 Files, and click Define Date Range to specify the desired date 
range as shown in the following figure.

Figure 58 - Define Date Range Dialog

Picarro software saves data in directories that are named by the creation year, month, and 
day as shown in the following figure. Select Data files are saved in directory trees named by 
date and time option if the target folder has this file structure. This allows Data File Viewer to 
only search folders within the desired date range, which can substantially reduce processing 
time. 

NOTE
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Figure 59 - File Structure of Data File Viewer

To save processing time, Data File Viewer does not open data files, but only determines 
data acquisition time based on the file name.

Do not define a time range for data files whose names have been changed.

Data File Viewer does not concatenate data files exactly within the defined time range. 
This is because the time extracted from file name is different from the data acquisition 
time. To not miss data points, Data File Viewer expands the specified time range, so the 
resulting dataset normally has a wider time range than the user specification.

NOTE

CAUTION

NOTE
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A.4.2 Convert DAT to H5
Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 format. These 
formats are described below:

 l DAT Format — DAT files accepted by DatViewer store tabular data (numbers and 
text) in plain text.

 o Each line of the file is a data record. Each record consists of one or more 
fields separated by whitespaces.

 o The first line of the data file indicates column names.
 o There must be a field “EPOCH_TIME” to store the acquisition epoch time 

(expressed as seconds since Jan 1, 1970) of the data. Otherwise, the first 
and second fields must be “DATE” and “TIME.” The “DATE” field must 
have the format “mm/dd/yyyy” or “yyyy-mm-dd,” and the “TIME” field 
must have the format “HH:MM:SS(.sss)” where (.sss) is an optional 
fraction of seconds.

 l HDF5 Format — HDF5 is a data model, library, and file format for storing and 
managing data. (See the HDF5 Home Page on the HDF Group website 
https://www.hdfgroup.org for more information.) When converting DAT to HDF5 
format, Data File Viewer creates a table named “results” to the contained data.

A.4.3 Convert H5 to DAT
Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. These formats are 
described in Convert DAT to H5.

Data File Viewer does not concatenate data files exactly within the defined time range. 
This is because the time extracted from file name is different from the data acquisition 
time. To not miss data points, Data File Viewer expands the specified time range. 

A.4.4 Interpolation
Interpolation describes the method for constructing data points with a range of a discrete set 
of known data points. Select File > Interpolation to perform interpolation on a time grid with a 
constant interval.

A.4.5 Block Average
Select File > Block Average to divide a dataset into small blocks based on a user-defined 
block size. The average is calculated for data in each block, and the results are saved in a 
new H5 file.

NOTE

https://www.hdfgroup.org/
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The specified block size must be greater than the average data interval.

Because the data interval is normally not a constant (unless interpolation is performed), 
fluctuations in the data interval will affect block averaging if the block size is comparable to 
the average data interval.

A.5   New – Time Series Plot
You can specify to include create time-series plots with one, two, or three frames. New plots 
display in the Time Series Viewer. 

Figure 60 - Time Series Viewer

This screenshot is for example only. The species shown on your analyzer may vary.

NOTE

NOTE
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The next section describes the options available on the Time Series Viewer menu bar. Refer 
to The Time Series Viewer Canvas or more information on the Time Series Viewer UI features 
and options.

A.6   Time Series Viewer Menus
This section describes the Time Series Viewer menu options.

A.6.1 Time Series Viewer File Menu
Use the File menu to save a configuration or take a screenshot. 

Figure 61 - Time Series Viewer – File Menu

A.6.2 Save Configuration
Click File > Save Configuration to open the Feature Capture form. With this form, you can 
save figure properties, expressions, filters, and other settings to a configuration file so that it 
can be easily loaded in the future. 

Figure 62 - Time Series Viewer – Feature Capture

If a feature is not captured, it will be omitted when the configuration file is loaded.

Depending on the features captured, loading a configuration file can have different effects. 
For example:

 l If all features are captured, a saved workplace is reproduced.
 l If a data file is not captured, saved parameters are applied to the data file in 

memory.
 l If an expression is not captured, plots will not be transformed.
 l If X (Y) range is not captured, figures are auto-scaled on the x (y) axis.

CAUTION
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A.6.3 Take Screenshot
Use File > Take ScreenShot to take a screenshot of the Time Series Viewer and save it as a 
.png to a specified file.

A.6.4 Time Series Viewer Analysis Menu
Use the Analysis menu to calculate statistics, generate a histogram, and to plot correlations 
and Allan Standard deviations. 

Figure 63 - Time Series Viewer – Analysis Menu

A.6.5 Statistics
Use Analysis > Statistics to calculate mean, standard deviation, and peak to peak for all 
plots in the current window.

A.6.6 Histogram
Use Analysis > Histogram to generate a histogram of data as shown in the figure below. 

Figure 64 - Histogram Window – CO2
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Histogram Window Features:
 l Red Line — A Gaussian function fitted to the histogram. Fitting results of μ

and σ are shown in the top-left corner of the plot.
 l Bin — Specifies the number of intervals that the range of values is divided into.
 l Normalized — When selected, the sum of the histograms is normalized to 1.
 l Save data — Saves histogram data to a CSV file.
 l Save image — Saves the histogram image as a JPEG, PNG, or PDF file.

A.6.7 Correlation Plot
Use Analysis > Correlation Plot to plot Y-axis data in one frame versus that in the other. This 
can be used when two or more frames exist in the current Time Series Plot window.

A.6.8 Allan Standard Deviation Plot
Use Analysis > Allan Standard Deviation Plot to create an Allan Standard Deviation plot 
(versus a standard deviation plot) for data in the current window. See Allan Variance 
Wikipedia page for more information.

A.6.9 Time Series Viewer View Menu
Use the View menu to view X-axis information in date-time, minute, or hour format. 

Figure 65 - Time Series Viewer – View Menu

When switching from Datetime to Minute or Hour, the X-axis data is subtracted from the 
earliest point shown in the panel and then converted to the desired unit.

A.6.10 The Time Series Viewer Canvas
The Time Series Viewer canvas (Figure 66) is comprised of interactive graphs and a variety of 
configuration options.

A.6.11 Mouse Options and Graph Transform
The following mouse actions can be used in the canvas graphs:

NOTE

https://en.wikipedia.org/wiki/Allan_variance
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 l Left-click and drag — Zooms into the selected area of the plot.
 l Left-click and drag with the SHIFT key down — Pans the plot.
 l Left-click and drag with CTRL key down — Zooms out from the plot.
 l Left-click and drag with ALT key down — Stretches the plot.
 l Right-click — Opens an additional menu. Refer to the Right-click menu below in the 

next section.

Figure 66 - Time Series Viewer Canvas

This screenshot is for example only. The species shown on your analyzer may vary.

NOTE
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A.6.12 Right-click Menu
Right-clicking on the canvas opens a pop-up menu: 

Figure 67 - Canvas Right-click Pop-up Menu

Export Image — Exports the current plot as a JPEG, PNG, or PDF file.

Export Data in Current View — Exports only date/time and the selected variable in the 
current view to an HDF5 or CSV file.

Export All Data in Current Time Range — Exports all variable columns of the selected 
dataset in the current time range to an HDF5 file. Refer to A.3.4, Concatenate H5 Files  for 
more information.

Edit Plot properties — Opens the Image Editor form (Figure 68), where the following options 
can be specified.

Figure 68 - Image Editor Form

Image Editor Form Options:
 l Title — Edits the title of the plot.
 l Line — Specifies the line pattern of the plot. If None is selected, the data points will 

be plotted without connecting lines.
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 l Marker — Specifies the marker type to indicate data points. If None is selected, 
data points will not be shown.

 l x-Axis — Min and Max: Specifies the minimum and maximum date range for the X-
axis.

 l x[0] — Sets the earliest time of the dataset as the minimum of the X-axis.
 l Time zone — Sets the time zone for date/time variables. This defaults to the local 

time zone.
 l Label — Specify labels for the X-axis and the Y-axis.
 l y-Axis — Min and Max: Specifies the minimum and maximum of data displayed on 

the Y-axis.

A.6.13 Dataset Name and Var Name
An HDF5 file can store one or more tables. Each of these tables is called a Dataset. A table 
can contain one or more columns. Each column is called a variable (Var).

Use the Dataset name drop down (Figure 69) to select the dataset that is used for this time 
series graph. Use the Var name drop down to select the column in the dataset to use in the 
graph.

Figure 69 - Time Series Viewer Dataset Options

A.6.14 Autoscale Y
When the Autoscale Y option is selected, the Time Series Viewer will autoscale on the Y-axis 
to make sure that all data within the range of the X axis is displayed. This feature can make it 
hard to see small signals when large signals blow the Y axis out, so it is often advisable to 
deselect this checkbox for dynamic or spikey datasets.

A.6.15 Average
If Block is selected, a block average is calculated when you click the Do average button. 
Otherwise, a moving average is calculated.
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For a block average, Size specifies block size in unit of a minute. For a moving average, Size 
specifies subset size in unit of data points. 

Averaging is performed after the filter and expression are performed.

A.6.16 Mean, Std Dev, and Peak to Peak
The Mean, Std dev (Standard deviation) and Peak to peak fields (Figure 69) provide all the 
statistical information of data in the current view.

A.6.17 Correlation/XY Plot
The Correlation/XY Plot window (Figure 70) includes two menu items: File and Analysis. For 
details about the File menu, see A.6.2, Save Configuration.

The canvas in this plot is interactive. For details about the plot canvas, see A.6.10, The 
Time Series Viewer Canvas.

Figure 70 - Correlation XY Plot

REMINDER

REMINDER
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A.6.18 Fitting Menu
The Fitting menu includes the four options that are described below.

Figure 71 - Fitting Menu

Fitting allows you to specify one of four fitting methods to include in the Correlation/XY plot:

  Linear Fit — Specifies to fit to linear function:
  y = c1x + c0
  Quadratic Fit — Specifies to fit to quadratic function: 
  y = c2x2 + c1x + c0
  Polynomial Fit — Specifies to fit polynomial function of degree n: 
  y = Σ cnxn
  Curve Fit — Specifies to use non-linear least squares to fit an arbitrary function to 

data. 

A.6.19 Analysis Menu
The Analysis menu has two options: Integration and Statistics.

Figure 72 - Analysis Menu

 1. Integration – Calculates area under the curve using the composite trapezoidal rule.
 2. Statistics – Calculates mean, standard deviation, and peak to peak for data in the 

current view. 
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After applying any of the above Analysis options, the results, statistics, or fitting function with 
coefficients are displayed in the lower portion of the Correlation Plot window (Figure 73). 

Figure 73 - Results of Quadratic Fitting
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B Setting up Contained Exhaust Flow
The A2000 vacuum pump is shipped with a noise dampener attached to the exhaust port. 
When a hazardous gas exhaust line from the pump is needed, it requires replacing the noise 
dampener with an adapter that allows a 1/4” OD exhaust tubing connection. Use the 
following instructions when installing a pump exhaust line.

Exhaust Port with Noise Dampener Vacuum Port

Figure 74 - A2000 Pump Vacuum and Exhaust Ports

B.1   Tools and Parts Required
 l Long flathead screwdriver (6” x 5/16” recommended) 
 l 9/16” open end wrench 
 l Swagelok ISO parallel thread adaptor 1/4"-1/8” SS-400-1-2RS (Picarro PN 22928)
 l Swagelok gasket SS-2-RS-2V (Picarro PN 22929)
 l 1/4" tubing and stainless-steel ferrule set
 l Snoop leak-detection fluid or similar soap solution

B.2   Directions
1. Remove the noise dampener fitting from the bottom of the pump using a long flathead 

screwdriver (Figure 75). 

1 2
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Noise Dampener 

Figure 75 - Pump Noise Dampener Removal

2. Slide the adapter gasket PN 22929 onto the adapter fitting PN 22928 (Figure 76), screw it 
into the pump exhaust port, and then tighten it 1/4 turn using a 9/16” wrench. 

3. Remove the Swagelok nut and ferules from the adapter fitting to ensure their orientation 
is as shown below, then loosely reattach to the adapter.

4. Slide the 1/4” exhaust tubing into the Swagelok nut and ferules until the tubing is fully 
seated, then using a 9/16" wrench, tighten the nut approximately seven flats (420 
degrees).

A guide to this process can be found on the Picarro Video Gallery here: 
https://mktg.picarro.com/acton/media/39674/picarro-video-gallery

Adapter Fitting PN 22928

Adapter Gasket PN 22929

Figure 76 - Pump Exhaust Line Adapter Fittings

1

1

2

https://mktg.picarro.com/acton/media/39674/picarro-video-gallery
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5. With the pump running on room air, apply Snoop leak detection fluid to the installed 
exhaust components to confirm that the system is leak tight. Instructions for leak testing 
using Snoop can be found in this video: https://vimeo.com/375518688 (go to time 5:20 
in the video)

https://vimeo.com/375518688
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C Analog Signal Output
This analyzer is configured with an optional Electrical Interface Card (EIC) that provides four 
analog signals for monitoring various measurement results and analyzer parameters.

Two circular connectors, on the back panel of the analyzer (are available for analog output. 
The pinout for each connector is listed in the table below. 

The following figure shows the analog channel connectors on the back of the analyzer.

Figure 77 - Analog Channel Connectors

Two external cables (for the analog channel connectors) are provided with the analyzer. The 
mating connector is part number HR25-7TP-8P(72).

C.1   Analog Signal Pin Mapping
The following table lists the analog pinouts and provides the analog pinout map.

Table 12 - Analog Pinout Table

Pin Function

 

Pin Function

1 GND 0 1 GND 4

2 Channel 0 2 Channel 4

3 GND 1 3 GND 5

4 Channel 1 4 Channel 5

5 GND 2 5 GND 6

6 Channel 2 6 Channel 6

7 GND 3 7 GND 7

8 Channel 3 8 Channel 7
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Figure 78 - Analog Pin Map

C.2    Configuration
+1 volt indicates 0 in all cases: Each channel has a +1 volt offset. Treat <=0 volts as an error. 
This helps prevent reading the wrong values because of improper wiring (ground loops). 

Example for Channel 0: 1V = 20 ppb with a 1V offset. 9v x 200 ppb/V = 180 ppb = 1.8 ppm.

The following table provides the master analog configuration.

Table 13 - Analog Configuration Master

Channel Parameter

Output Scale

(<1V indicates 
error)

Conversion

All channels have a 
+1V offset

(+1V=0)

Indicating Range

1V to 10V or 0 to 
90 ppb

0
NH3 

concentration
0-10V 10 ppb/V 0 to 90 ppb

1
NH3 

concentration
0-10V 100 ppb/V 0 to 0.9 ppm

2
NH3 

concentration
0-10V 2 ppm/V 0 to 18 ppm

3
H20 

concentration
0-10V 2%/V 0 to 18 ppm

4 DAS Temp 0-10V 10o C/V 0 to 90oC

5 None NA NA NA

6 None NA NA NA

7 None NA NA NA
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D Analog Current Signal Output
Four channels of 4-20 mA current analog output are available on the back of the analyzer. 

Figure 79 - 4–20 mA Output with Terminal Connector

By default, the settings for the four channels are as follows:

Table 14 - Signal Output Settings

  Iout0 Iout1 Iout2 Iout3

Monitoring NH3 H2O DAS Temperature Cavity Pressure

Units ppb % Degrees C Torr

Min 0.0 0.0 0.0 0.0

Max 1000.0 20.0 100.0 1000.0

 l NH3 — Displays the NH3 concentration reading in parts per billion (ppb)
 l H2O — Displays H2O in percent (%)
 l DasTemperature — Displays the internal logic board temperature in degrees 

Celsius
 l CavityPressure — Displays the cavity pressure in Torr

D.1   Connecting the 4–20mA Signal Output
To connect to the output:

1. Using your fingers, pull the 4–20 mA terminal connector straight back away from the 
analyzer.
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Figure 80 - Removing the Terminal Connector

2. Use a small slotted screwdriver to loosen the retaining screw for the desired terminal.

Figure 81 - Terminal Connector Retaining Screws

3. Insert the stripped end of the wire into the terminal.

4. Tighten the retaining screw.

5. Repeat for each desired terminal.

6. Slide the terminal connector back onto the analyzer with the retaining screws facing 
down; there should be a soft click when the connector is set into its proper position.

If shielding is desired, connect the drain wire of the shielded cable to the ground lug 
on the back panel. Do not connect the shield to the ground pins of the 4–20 mA 
connector. Connect only one end of the shielded cable to the ground lug to avoid 
ground loops.

NOTE
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E Serial Communication Protocols
The Serial Port Menu is accessible from the Config Menu and displays the configurations of 
COM1 (used for Command Interface) and COM3 (used for Data Out). The COM1 port is 
preconfigured, and its settings cannot be changed. The COM3 port can be enabled or 
disabled, and the following settings can be configured:

 l Baud rate — The number of bit transfers per second.
 l Data Bits —  The number of data bits in a communication packet, or a single byte 

transfer.
 l Stop Bits —  The number of bits used to signal the end of a communication packet.
 l Parity —  Sets the parity bit to Even, Odd, Mark, Space, or None.

After making any changes, select Save to apply the changes or Undo to revert to the 
previous configuration.

Figure 82 - Default Serial Port Configuration

E.1   COM1 (Command Interface) Protocol
The headers below correspond to each column of data and are not included in the output:

CavityPressure, CavityTemp, DasTemp, EtalonTemp, WarmBoxTemp, species, 
MPVPosition, OutletValve, solenoid_valves, NH3, H2O, NH3_Raw, NH3_sigma, NH3_tau, 
nh3_base_11, ymd, hms

Output Frequency:

Data will output when command is sent to COM1 via RS232.
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E.2   COM3 (Streaming) Protocol
The column headings for the streaming interface are as follows:

Column Description

Column0 Timestamp

Column1 CavityPressure

Column2 CavityTemp

Column3 DasTemp

Column4 EtalonTemp

Column5 WarmBoxTemp

Column6 species

Column7 MPVPosition

Column8 OutletValve

Column9 solenoid_valves

Column10 NH3

Column11 H2O

Column12 NH3_Raw

Column13 NH3_sigma

Column14 NH3_tau

Column15 nh3_base_11

Column16 ymd

Column17 hms

The data in columns 12-17 are reserved for diagnostic use by Picarro authorized 
technicians.  

E.2.1 Output Frequency:
The data outputs automatically in real time similar to the GUI display.

NOTE
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F External Valve Sequencer 

F.1   Introduction
The Picarro analyzer can control two types of valves:

 l Rotary Selector Valve — Digitally controlled valve used to send selected flow from 
one of many inputs (up to 16) into the analyzer.

 l Solenoid Valves — DC voltage powered valve with normally open (NO) and 
normally closed (NC) positions. These can be 2-way or 3-way valves.

Both types of valves can be simultaneously controlled through a common software interface 
called the External Valve Sequencer (described in F.7, External Valve Sequencer Software 
Overview) which is available from the Tools menu on the GUI.

Picarro offers two rotary valve and two solenoid valve solutions:
 l A0311 — 16-Port Distribution Manifold.
 l A0311-S — 16-Port Distribution Manifold (Silco) which is optimized for use with 

sticky and reactive gases.
 l S3112 — 3-Way stainless steel solenoid valve with 1/4” fittings.
 l S3136 — 3-Way stainless steel solenoid valve with 1/8” fittings.

F.2   A0311 16-Port Distribution Manifold

F.2.1 Compatibility 
The A0311 (Figure 83) is broadly compatible with most Picarro analyzers except for those 
with known surface and chemical compatibility issues (such as the G2103, SI2103, SI2108, 
SI2104, SI2205, G2307, G2509, and PI2114).

F.2.2 Function
The A0311 and External Valve Sequencer GUI makes it easy to program the sequence and 
duration of sample intake from various attached sampling lines, flasks, or bags. The manifold 
is controlled using either the Picarro analyzer GUI or an external hand-pad (included with the 
A0311).

The A0311 samples up to 16 gas sources. During operation, the selected line is routed 
through the valve into the analyzer. The 15 lines that are not selected terminate in the valve.

For detailed instructions on integrating the A0311 with your analyzer, refer to the 16-Port 
Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038).

 

NOTE
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Figure 83 - A0311 – 16-port Distribution Manifold

F.3   A0311-S 16-Port Distribution Manifold (Silco)

F.3.1 Compatibility
The A0311-S (Figure 84) is broadly compatible with all Picarro analyzers but is optimized for 
use with sticky and reactive gases in the following platforms, nominally:

 l G2103, SI2103, SI2108, SI2104, SI2205, G2307, G2509, and PI2114

F.3.2 Function
For users who require faster response performance, the A0311-S is a 16-Port distribution 
manifold with a flow through valve for reduced memory effects. Designed to optimize 
response time in the presence of reactive gases, the A0311-S uses SilcoNert® coated 
components, PFA tubing, and an additional vacuum pump.

The sampling duration and sequence is easily programmed through the Picarro External 
Valve Sequencer GUI. This design is ideal for fast switching between different locations for 
specialty applications in semiconductor, pharmaceutical, environmental research, and other 
industries. 

For detailed instructions on integrating the A0311-S with your analyzer, refer to the 16-
Port Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038).

Figure 84 - A0311-S – 16-Port Sequencer – Fast Multiport Gas Sampler

NOTE
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F.4   Valve Control Configurations
For all models of Picarro analyzers, the rotary valve control is disabled in the factory default 
setting. The solenoid valve control, however, is enabled by default for all solenoid valve 
connectors. 

To configure an analyzer for operation with an A0311 rotary valve, the user must first confirm 
that the COM port chose on the back of the instrument for connection to the rotary valve is 
consistent with the COM port specified in the Data Manager. Refer to E, Serial 
Communication Protocols for instructions to change to rotary valve configuration (the Valve 
Sequencer MPV field) and to ensure the correct COM port is enabled.

Only use supported 12V, <500 mA, solenoids (listed above in F.1, Introduction). Using 
unsupported solenoids may result in damage to the power board.

F.5   Setting Up Solenoid Valves
The Valve Sequencer software can control up to six solenoid valves. Each valve should 
operate using 12 VDC with a maximum quiescent current of 500 mA. Most analyzers come 
with a valves cable that can be connected to the solenoid valves, and if not, one can be 
purchased by contacting support@picarro.com.

Be careful to avoid shorting the solenoid valve output pins, as this will blow the relays on 
the power board, requiring a costly replacement.

The valve connector cable should be connected to the 15-pin connector at the lower left 
corner of the analyzer. There are six pairs of wires with connectors labeled V1, V2, … V6 with 
2-pin female Molex connectors (Molex #43020-0200) for connection to the solenoid valves. 
For valves wired with matching Molex connectors, connect V1 to the solenoid valve 1, V2 to 
solenoid valve 2, etc. Do not connect the solenoid valve to the analyzer ground – use only the 
provided electrical connectors.

F.6   Setting up a Rotary Selector Valve
The (null modem) 9-pin female connector cable should be attached to its corresponding 9-
pin male port (COM 2) on the analyzer. The other end of the cable connects to the 9-pin port 
on the A0311. Please note the 9-pin connector cable is not supplied with the instrument – 
only as part of the A0311 kit.

CAUTION

CAUTION

mailto:support@picarro.com
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F.7   External Valve Sequencer Software Overview
The External Valve Sequencer software allows the user to define a sequence of (repeating) 
steps within which rotary valve positions and/or solenoid valve positions can be defined 
uniquely at each step.

F.7.1 Opening the Sequencer
From the CRDS Data Viewer, Users dropdown menu login using your username and 
password. Then, from the Tools drop-down menu, select Show Valve Sequencer GUI. The 
Picarro valve sequencer window displays, but typically sitting behind the main GUI. Hitting 
alt-tab brings the Valve Sequencer GUI to the front.

Figure 85 - Launching the Valve Sequencer GUI

F.7.2 Valve Sequencer UI Menus
The sequencer GUI provides the following dropdown menu options.

Figure 86 - Valve Sequencer UI Dropdown Menus
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The following figure provides functional descriptions of the External Valve Sequencer UI.

Current step and valve state status panel (when sequencer is running)

Sequencer configuration controls

Figure 87 - External Valve Sequencer UI

The Current Step #, the Remaining Time (min), and the Current Valve State are shown in the 
topmost row of the valve sequencer command window. The duration of each step is set in 
decimal minutes; for example, 15 seconds would be entered in as 0.25 minutes.

While a sequence is inactive, Current Step # will typically read “0”. Once the user has 
selected Start Sequence from the Action menu, or once the user clicks Apply from the GUI, 
the Current Step value will change to 1, corresponding to the first step defined below it, and 
will continue through the steps, returning to Step 1 once the last step is completed. 

If a user wishes to perform a set of steps only once, they may set a final step with a very long 
duration, or wait until the sequence is finished, and at the end of the last step, click Stop 
Sequence from the Action menu.

Under Action, the Go to First Step menu item restarts the sequence from step 1. When the 
first step in the sequence starts, the “Current Step” value will change to “1”. This will begin 
the sequence if the sequence is currently active.

1

2
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F.8   Programming and Saving a Valve Sequence
Each “step” in the sequence can be used to set the rotary valve to a given position or activate 
selected solenoid valves for a set period. Multiple steps can be carried out in sequential 
order to switch between different gas sources, flush out a manifold, or to perform other gas 
handling operations. 

1. Create the number of desired steps in the sequence by clicking the up/down arrow for 
Total Steps.

2. For each step, select the box for each solenoid valve to be opened. The check mark in 
the Current Valve State window indicates a solenoid valve is set to its “normally closed” 
value in the case of a 3-way, or to its “open” value in the case of a 2-way on/off valve. The 
positions from left to right correspond to solenoid valves V1 to V6.

3. The rotary selector valve position can be set in the column labeled Rot. Valve Code. 
Enter the number that corresponds to the desired valve position. A value of 1 in this field 
corresponds to position 1 on the rotary valve. Only one rotary position can be selected 
per step. 

4. The upper right box, Current Rot. Valve Code, displays the current value while a 
sequence is active. It should be white if a rotary valve is connected, turned on, and 
detected by the software. If the box is grayed out, the rotary valve is not detected (if so, 
consult your rotary valve manual).

5. For each step, set the desired Duration. This is determined by the value entered in the 
Duration (min) field, where the duration of the step is in minutes. If duration values are set 
to <0.1 minutes, they may not be carried out accurately.

6. The Valve Code column (not used with the rotary valves) is a configuration-dependent, 
read-only display field that shows the total state of that particular step in a numerical 
binary sum of form 2 (Valve Number -1). When powered, the following valve values are 
produced, and then added together for the final Valve Code.

  Valve 1 Powered = 2(Valve number-1) = 2(1-1) = 1

  Valve 2 Powered = 2(Valve number-1) = 2(2-1)= 2

  Valve 3 Powered = 2(Valve number-1) = 2(3-1)= 4

  Valve 4 Powered = 2(Valve number-1) = 2(4-1) = 8

  Valve 5 Powered = 2(Valve number-1) = 2(5-1)= 16

  Valve 6 Powered = 2(Valve number-1) = 2(6-1)= 32

The maximum displayable value is 63 (=1+2+4+8+16+32), when valves 1-6 are all 
powered. All other combinations of valves are unique binary sum values which denote 
the specific combination of any of the six valves.
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This Valve Code value active at a particular point in time can be shown in the main 
Picarro software GUI as SolenoidValves or sometimes ValveMask (this may require 
going to Settings > Service Mode > password picarro). The Rotary valve code can be 
displayed as MPVPosition.

Figure 88 - Example 15 Minute Sequence

Above is a 15 minute valve sequence. It opens 5 minutes for each solenoid valve (#1, 
#2 and #3), and each of rotary valve (#4, #5 and #6).

7. Once the valve sequence has been programmed, it can be saved by selecting Save Valve 
Sequence File under the File menu (Figure 86). The sequence may be saved with any 
name the user chooses. 

NOTE
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F.9   Loading and Running a Saved Sequence

F.9.1 Loading a Saved Sequence
1. Under the File menu, select Load Valve Sequence. 

All the sequence files are in:

/Home/Picarro/I2000/InstrConfig/ValveSequencer/Name of the Sequence File

2. To load an existing valve sequence file, select the desired sequence name. 

If the user has been running a different sequence from the one that was loaded, the user 
needs to press Run Next Step to initialize the newly selected sequence, or alternately go 
to File > Go To First Step and Start Sequencer.

F.9.2 Running a Sequence
1. Under the Action menu, select Start Sequencer.

This selection will change to Stop Sequencer once the sequence starts. (The sequencer 
should be activated if it was disabled, but not necessarily to change from one sequence 
to another.) The sequence will repeat itself indefinitely until disabled or the software is 
exited. 

2. Once the sequencer is running, the user can select Hide Sequencer Interface under the 
Action menu; the sequence will continue to run even with the UI hidden, and will 
automatically continue if the instrument ever loses power from the wall and restarts after 
power is restored. (However, the timing of the sequence will be offset relative to the 
intended cadence.) 

3. To bring the sequencer interface back into view, from the main Picarro GUI, go to Tools > 
Show/hide Valve Sequencer again.

F.9.3 Skipping Steps or Advancing to a Particular Step
If desired, the valve sequence can be forwarded to the next step of the sequence by clicking 
the Run Next Step button on the UI. To jump to a particular step, increment the Run Step # 
field and click Apply.

F.9.4 Stopping the Sequencer 
1. Under the Action menu, select Stop Sequencer. 

This will leave all valves in their current state. In some situations, it is convenient to 
program the last step in the sequence to be a safe or default valve state. 

2. Should the user need to put the solenoid or rotary valves into a safe/default state, the 
sequencer can be advanced to the last step using the Run Next Step button. 



F External Valve Sequencer

130 PN 40-0120, REV B PI2103 User Manual

F.9.5 Resetting Valves
Under the Action menu, selecting Reset All Valves will deactivate/reset all valves to their 
default state. 

F.10   Scheduling a Sequence
Users may schedule a sequence to start at a particular time in the future, often at the top of 
the hour, or at midnight for a recurring sequence with an hourly or daily cadence. The 
Schedule Sequence button is typically greyed out when the user shows the valve sequencer 
because the start time has passed. To begin a run in the future, select the desired date under 
Start Date, and the desired time under Start Time. When both values are in the future, the 
Schedule Sequence button will become active, and the user may click it. When the 
scheduled time arrives, the sequence will start automatically.
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G Relative Humidity Conversion
H2O Concentration (C) is reported in units of parts per hundred or percent (%) and is a 
volumetric fraction of water vapor to total (wet) gas. Via the ideal gas law, the concentration 
can be related to the water vapor pressure (PW) and the total pressure (P).

A popular way to express volumetric concentration when working with humidity is in terms of 
total (dry) gas.

The two concentration definitions can be related by

    or    

Relative Humidity (RH) is the percentage of water vapor pressure to the saturated water 
vapor pressure (PWS).

There are several empirically generated equations that provide the saturation vapor pressure 
as a function of temperature (T). A simple and effective relationship for use within a 
temperature range of -45 °C to 60 °C is provided by the Mangus formula with coefficients 
adjusted by Sonntag [1].

Where, α = 4.584 Torr, β = 17.62 and λ = 243.12 °C
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Combining the equations shown above yields the final relationship for converting the wet and 
dry definitions of concentration to relative humidity.

For example, a wet concentration of 1.5% H20 at 18.0 °C and 760.0 Torr yields a relative 
humidity of 73.8%.

A dry concentration of 1.5% at 18.0 °C and 760.0 Torr yields a relative humidity of 72.7%.

[1] Sonntag D.: Important New Values of Physical Constants of 1986, Vapour Pressure Formulations based on the 
ITS-90 and Psychrometer Formulae; Z. Meteorol.70 (1990) 5, 340-344
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H Introduction to Technology
Picarro analyzers use time-based, optical absorption spectroscopy of the target gases to 
determine concentration. They are based on wavelength-scanned cavity ring-down 
spectroscopy (WS-CRDS), a technology in which light re-circulates many times through the 
sample, creating a very long effective path length for the light to interact with the sample, 
thus, enabling excellent detection sensitivity in a compact and rugged instrument. 

The Picarro analyzer is comprised of two modules:
 l The analyzer contains the spectrometer, sample chamber, and a computer with a 

hard drive to store and analyze data. The single analyzer module controls the 
operation of the system and converts spectroscopic measurements into gas 
concentration data.

 l The external vacuum pump draws the sample gas through the instrument.

H.1   Cavity Ring-Down Spectroscopy (CRDS)
Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and isotopologue (e.g., 
H2

18O, 13CO2, 15N14N16O) uniquely absorb specific wavelengths of near-infrared light. The 
strength of the light absorption is related to the concentration of a molecule in a sample and 
the distance that light travels through the sample, called the path length. 

Conventional infrared spectrometers are typically only sensitive enough to detect trace 
gases at levels in the part-per-million. Cavity Ring-Down Spectroscopy (CRDS), on the other 
hand, is one thousand to one million more times sensitive. 

The increased sensitivity of CRDS is due to the design of the sample cavity and the time-
based measurement. In the cavity, a series of mirrors reflects the infrared light through the 
sample, increasing the path length. For a Picarro cavity of only 25 cm in length, the effective 
path length of the cavity can be over 20 kilometers.

In Picarro analyzers, light from a single-frequency laser enters a cavity where three mirrors 
reflect the laser light as seen in Figure 1. The light enters through the mirror closest to the 
laser, bounces off the angled mirror in the lower right corner of the cavity, travels to the 
hemispherical mirror at the top of the cavity, bounces toward the mirror in the lower left 
corner of the cavity, and then returns to the first mirror. This motion becomes a continuous 
traveling light wave, which is represented by the dark orange path in Figure 1.
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Figure 89 - Schematic of the Picarro CRDS analyzer cavity

When the laser is on, the cavity quickly fills with laser light. A small amount of the laser light is 
transmitted through the mirror closest to the photodetector, which turns the incident light 
into a signal that is directly proportional to the light intensity in the cavity.

When the photodetector signal reaches a threshold level (in a few tens of microseconds), the 
laser is turned off. The light contained within the cavity continues to bounce between the 
mirrors (about 40,000 times). Since the mirrors have slightly less than 100% reflectivity 
(99.999%), the light inside the cavity steadily leaks out of the cavity. The intensity of the light 
reaching the detector decreases, falling exponentially until it reaches zero. This decay, or 
"ring-down,” is measured in real time by the photodetector.

H.2   Relating Ring-Down Time to Absorption Intensity
The time it takes to ring-down is inversely related to the total optical loss in the cavity, 
including the strength of molecular absorption at a given wavelength of light. For an empty 
cavity, the time it takes for the intensity to decrease by a given percent is determined solely 
by the reflectivity of the mirrors. A cavity containing gas that absorbs light will have a shorter 
ring-down time than an empty cavity. As the light circulates in a cavity with a gas sample, the 
molecular absorption by the gas results in a decrease of the light intensity.

Determining absorption intensity at a specific wavelength requires comparing the ring-down 
time of an empty cavity to the ring-down time of a cavity that contains gas. A cavity can be 
empty if it contains no gas; it will also appear empty if the molecules of the sample inside the 
cavity do not interact with the specific wavelength of light.
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Picarro instruments gather measurements from an “empty” cavity by switching the light to 
wavelengths that are not absorbed by the target molecules. The analyzer subsequently 
measures ring-down times at wavelengths that are absorbed by the target gas. The analyzer 
automatically and continuously compares these two types of ring-down times, and the 
software uses those comparisons to calculate absorption intensities.

Figure 90 - Light intensity as a function of time in a CRDS system

H.3   Converting Absorption Intensity to Concentration
Plotting the absorbance at each measured wavelength generates an optical spectrum. This 
spectrum contains absorbance peaks that are unique to each molecule in the sample. The 
height of a particular absorption peak is proportional to the concentration of a molecule that 
generated the signal. 

The height of the peak is calculated by subtracting the maximal absorbance from the 
baseline absorbance. Figure 91 shows a plot of ideal optical spectra with a clean, uniform 
baseline on either side of the absorption peak.
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Figure 91 - Absorption Spectral Curve

However, optical spectra often contain several absorption lines, nested closely together. A 
particular absorption peak may be visible between lines, but the absorption may not return to 
the baseline before it rises in response to another molecule. Picarro analyzers calculate the 
baseline underneath a poorly resolved peak by modeling the absorption peaks from other 
surrounding molecules and subtracting contributions from neighboring peaks to the 
absorption intensity. 

H.4   Spectral Precision and High Sensitivity Measurements
Picarro analyzers contain two features that provide high spectral precision:

 l Proprietary wavelength monitor (WLM) that measures the absolute laser 
wavelength to a precision that is a few orders of magnitude narrower than the 
spectral linewidth: Picarro’s patented WLM measures absolute laser wavelength to 
a precision more than 1,000 times narrower than the observed Doppler-broadened 
linewidth for small gas-phase molecules. The instruments lock the laser to the 
WLM, and then the monitor tunes to wavelengths known to be maximally and 
minimally absorbed by the target molecule. The result is closely clustered 
absorption intensities, measured at wavelengths just before peak absorption, at 
peak absorption, and just after peak absorption, as the absorbance returns to the 
baseline.
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 l Precise temperature and pressure control in the sample cavity: Accurate absorption 
measurements at precisely known wavelengths account for little unless the 
temperature and pressure of the CRDS measurement cavity are known. The 
observed line intensity and shape depend on the temperature and pressure inside 
the sample cavity. Small temperature and pressure instabilities can result in large 
concentration errors due to fluctuating peak heights and baselines. To completely 
minimize instrument measurement drift, temperature and pressure must be actively 
stabilized to constant values. 

For precise temperature control, the sample cavity is surrounded by layers of thermally 
insulating material to provide a high degree of passive thermal stability. The cavity is further 
actively stabilized by means of a solid-state heating system locked to the output of a thermal 
sensor. This enables the temperature of the cavity to be within 20 mK of the set temperature. 

For precise pressure control, the cavity pressure is monitored using a high-linearity pressure 
transducer. The system computer uses this pressure data in a feedback loop to control 
proportional valves that adjust the inlet and outlet gas flow of the cavity. 
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I Limited Warranty
Picarro, Inc. warrants its Products to be free from defects in material and workmanship and 
to perform in the manner and under the conditions specified in the Product specifications for 
twelve (12) months from shipment.

This warranty is the only warranty made by Picarro with respect to its Products and no 
person is authorized to bind Picarro for any obligations or liabilities beyond this warranty in 
connection with its Products. This warranty is made to the original Purchaser only, is non-
transferable and may only be modified or amended by a written instrument signed by a duly 
authorized officer of Picarro. Sub-systems manufactured by other firms, but integrated into 
Picarro Products, are covered by the original manufacturer’s warranty and Picarro makes no 
warranty, express or implied, regarding such sub-systems. Products or parts thereof which 
are replaced or repaired under this warranty are warranted only for the remaining, un-expired 
portion of the original warranty period applicable to the specific Product replaced or 
repaired.

DISCLAIMER

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL OR IMPLIED, AND SHALL BE THE 
PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN CONTRACT OR 
OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

The Purchaser’s exclusive remedy with respect to any defective Product shall be to have 
Picarro repair or replace such defective Product or credit the Purchaser’s account, 
whichever Picarro may elect in its sole discretion. If it is found that any Product has been 
returned which is not defective, the Purchaser will be notified and such Product returned at 
the Purchaser’s expense. In addition, a charge for testing and examination may, at Picarro’s 
sole discretion, be made on any Product so returned.

These remedies are available only if: 1) Picarro is notified in writing by the Purchaser 
promptly upon discovery of a Product defect, and in any event within the warranty period; 2) 
Picarro’s examination of such Product discloses to Picarro’s satisfaction that such defects 
actually exist and the Product has not been repaired, worked on, altered by persons not 
authorized by Picarro, subject to misuse, negligence or accident, or connected, installed, 
used or adjusted otherwise than in accordance with the instructions furnished by Picarro.

NOTE
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The following warranty conditions shall apply to all Picarro, Inc. products unless amended by 
a written instrument signed by a duly authorized officer of Picarro:

ADJUSTMENT — No electrical, mechanical or optical adjustments to the product(s) are 
permitted.

PARTS AND LABOR — New or factory-built replacements for defective parts will be 
supplied for twelve (12) months from date of shipment of the product. Replacement parts are 
warranted for the remaining portion of the original warranty period. There will be no charge 
for repair of products under warranty where the repair work is done by Picarro, Inc. 

NOT COVERED BY THE WARRANTY — Damage to any optical surface from improper 
handling or cleaning procedures. This applies specifically to those items subjected to excess 
laser radiation, contaminated environments, extreme temperature or abrasive cleaning. 
Damage due to ESD, abuse, misuse, improper installation or application, alteration, 
accident, negligence in use, improper storage, transportation or handling. No warranty shall 
apply where the original equipment identifications have been removed, defaced, altered or 
where there is any evidence of alterations, adjustments, removal of protective outer 
enclosure, any attempt to repair the product by unauthorized personnel or with parts other 
than those provided by Picarro, Inc. 

DAMAGE IN SHIPMENT — Your analyzer should be inspected and tested as soon as it is 
received. The product is packaged for safe delivery. If the product is damaged in any way, 
you should immediately file a claim with the carrier or, if insured separately, with the 
insurance company. Picarro, Inc. will not be responsible for damage sustained in shipment. 
All Picarro products are F.O.B. origin, shipped from the Picarro factory or Picarro distributor. 
The price of all Products, unless otherwise specifically stated, is Ex- Works, Sunnyvale, CA 
as defined by Incoterms, 2001. The cost of normal packaging for shipment is included in the 
invoiced price. Where Buyer specifies special packaging, a charge will be made to cover any 
extra expense.

CLAIMS ASSISTANCE — Call Picarro, Inc. ustomer Service or your local distributor for 
assistance. Give our representative the full details of the problem. Helpful information or 
shipping instructions will be provided. If requested, estimates of the charges for non-
warranty or other service work will be supplied before work begins.

RETURN PROCEDURE — Customers must obtain a Return Merchandise Authorization 
Number from Picarro, Inc. prior to returning units. Products being returned for repair must be 
shipped in their original shipping cartons to avoid damage.



About Picarro         
Picarro is a leading provider of solutions to measure greenhouse gas (GHG) concentrations, trace 
gases, and stable isotopes across many scientific applications, along with the energy and utilities 
markets. Our patented Cavity Ring-Down Spectroscopy (CRDS) is at the heart of all Picarro instruments 
and solutions, enabling the detection of target molecules at part per billion or better resolution.

Product Support

Utilize Picarro support resources for product support. Join the Picarro community to ask 
questions and get answers, search the document library for datasheets and user manuals, 
download software, and purchase products and replacement parts. 

 
Access to online community forums and software downloads are available only for registered 
Picarro customers with login credentials. If you do not have an account, you can register by 
using the community and software download links below.

 

  Picarro Document Library
  Picarro Community (Forums)
  Picarro Software Downloads
  Picarro Literature (Scientific Resources)
  Picarro Web Store

Contact Picarro for questions regarding specific applications and additional information.

Picarro Customer Support: Customer Service:

Email: support@picarro.com Email: support@picarro.com
Phone: +1 408 962 3991 (USA) Phone: +1 408 962 3992
  +31 85 888 1650 (International)    

https://www.picarro.com/support/documents
https://www.picarro.com/support/community
https://www.picarro.com/support/downloads
https://www.picarro.com/support/literature
https://store.picarro.com/
mailto:support@picarro.com
mailto:support@picarro.com
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